
About Evolution Audio Pro...
Displays a Dialog with brief details about the program.



Arrange Icons
Rearranges any icons (minimized windows) on the desktop, starting at the bottom left.



Audio System Settings...
If your computer contains a sound card capable of audio playback, you can configure it here.

The .WAV files are read direct from hard disk, so it is possible to play files of any length - you
can play any file which can fit on the hard disk.

The Dialog contains the following:

Audio System On / Off This determines whether the audio system is active. Turning it off 
frees the wave audio driver so it can be used by another program. It also frees all memory 
used by the audio system.

Realtime Format Conversion If this switch is on, the program will convert the format of 
any wave file which does not match the current playback format. The necessary calculations
are done in real time during playback. Conversions of quarter, half, double and quadruple 
speeds are possible. If you can still hear waves being played back at the wrong speed, 
choose a Playback Format which is closer to that of the files you are using.

Buffer Size This combo box allows you to decide how much of the PC's memory is used for 
buffering the audio data. In general, the slower your PC, the larger the buffer you will need. 
If you are using Realtime Format Conversion you will need more buffer memory. If you hear 
gaps in the playback of a wave file, try increasing the buffer size.

Playback Format The three sets of radio buttons allow you to set the format of your sound 
card to the format of the wave files you intend to use. The Audio Pattern Settings Dialog will 
tell you the format of any wave file. If your wave files are not all the same format, turn on 
Realtime Format Conversion so they will be replayed correctly.

Show Names in Patterns If this switch is on, the names of audio patterns are displayed in 
the Track Window.

Draw Waves in Patterns If this switch is on, the program will show a graphic 
representation of wave files inside the patterns.

Draw Waves in Dialogs If this switch is on, the program will show the wave file in the 
Audio Pattern Settings Dialog.

OK Pressing this button exits the dialog, and acts on the settings you have made.

Cancel Exits the dialog without acting on the settings you have made.

See also:
Audio Pattern Settings.



Cascade Windows
Overlaps all open windows but does not disturb the Transport, Editors or Fast Menu Windows.



Change Lengths...
Allows you to change the length of one or more notes. It displays a Dialog where you set the 
amount by which the notes will be changed, and the Scope of the change.

The lengths may be changed in the following ways:

By Amount Make notes Longer or Shorter by a definable number of ticks.
Make Legato Change so there are no rests between the notes.
Remove Overlaps Change so notes don't overlap.
Fixed Length Make all notes the same length.



Change Timing...
Allows you to change the time taken to play a group of events. It displays a Dialog where 
you set the Percentage of the original time for the events to be played in. For example, a 
setting of 50% will result in the notes being played in half the time, while 200% will make 
them play in double the time of the original. All types of event are affected, so a melody line 
with pitch bend will still sound right after having its timing changed - the relative positions of
the notes and pitch bend data will be maintained.



Change Velocity...
Allows you to change the velocity of one or more notes. It displays a Dialog where you set 
the Amount by which the notes will be changed, and the Scope of the change. You can 
change velocities Up or Down or set all velocities to a Fixed amount. Use the Maximum 
and Minimum settings to limit the change in velocity.



Clear
Removes the selected items from the song.



Clipboard

An area of computer memory used for temporary storage of data.



Close All
Closes all windows which are capable of being closed except the Track Window.



Conductor Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

To get to the furthest extent of a zoom, hold down the Control key while clicking on a zoom 
button.

Button

Close the window.

Selector

This affects how Conductor Points line up when you move them. For example, if it is set to 
'Bar', they will 'snap' to the nearest bar.

Displays

1. The Information Line shows detailed information about a selected point. You can adjust 
these values with the mouse.

2. The Time line shows the bars and beats currently being displayed. The width of each bar 
depends on the Time Signature - this can change if there are Time Signature changes 
defined in the Time Signature Display. By clicking on the time line while holding down the 
CONTROL key, the Play Position will jump to the mouse position.

3. The Time Signature Display is where Time Signature Points are shown. The horizontal 
position indicates time.

4. The Key Signature Display is where Key Signature Points are shown. The horizontal 
position indicates time. 

5. The Tempo Display is where Tempo Points are shown. The horizontal position indicates 
time. The vertical position indicates tempo - the higher the point, the faster the tempo.

Selecting Conductor Points



You can select points in any one of the three displays with either of these two methods:
1. Click on a point - it changes colour to indicate selection. Click on another one and 

that becomes the selected point. If you hold SHIFT and click on a point you can toggle its 
status between selected and normal. By using SHIFT clicking you can select several points.

2. With the left mouse button click on a part of the display where there isn't a point. 
Any selected points become deselected. While still holding down the left mouse button, drag
down and to the right, enclosing points in the dotted 'drag rectangle' as you go. Release the 
mouse button. The points inside the drag rectangle become selected. This method is called 
lassoing.

When one point is selected, detailed information about it is given in the Information Line. You
can use the Up and Down arrow keys to move selection to adjacent points.

Using the Edit functions

When using functions from the Edit menu, whether points are affected depends on their 
selection states. If you have selected one or more points, those points will be affected. If no 
points are selected, none will be affected.
One method of copying one or more points is to select them and use the Copy function to 
place a copy of them on the clipboard. You can then Paste them into the display at the 
current Play Position.

Moving and Copying Conductor Points

Selected points can be moved and copied. Click on any one of the group and drag to a new 
position then let go of the mouse button. If you hold down the CONTROL key before you 
click, a copy of the points will be made at the new position, leaving the originals intact. The 
newly copied points then become the selected ones. Time and Key Signature Points can be 
dragged horizontally only. The first Tempo Point can only be dragged vertically to make sure 
it stays at position 1:01:000. The first Time and Key Signature Points cannot be dragged at 
all for the same reason.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool 
Selector. Move the mouse until the one you want is highlighted. Let go of the right mouse 
button - the selector disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button 
and release immediately - there's no need to drag.

2. The Pencil is used for entering new points. Click in the Time Signature, Key Signature or 
Tempo Displays and a new point is added. A warning message is displayed if there is already
a point at that position. Time Signatures must be entered on bar lines in order to make 
musical sense. When you enter a Time Signature, it will be 4/4. If you need to change this, 
click on it to select it, then change its value in the Information Line with the left and right 
mouse buttons. Similarly, a Key Signature starts off as C, so click on it and change it in the 
Information Line to the signature you require.

3. The Eraser is used to delete points. Click on a point with the eraser and it disappears. If 
you click on one of a group of selected points, all the selected points are deleted. The first 



entry in each display cannot be deleted - in order to make musical sense the Conductor 
must contain an initial Tempo, Time Signature and Key Signature.

Playback

During playback the Transport Window shows the changing Tempo and Time Signatures 
providing the Conductor Switch is turned on.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

See also:
General Window Information, Transport Window.



Configure Fast Menu...
Displays a Dialog where the contents of the Fast Menu Window can be chosen.

To add a function, click on its name in the Functions list, then click on the Add button. The 
new function will now be visible in the Selections list. You can change the order in which a 
function will appear by clicking on its name in the Selections list, then clicking on the Up or 
Down buttons.

To remove a function from the Selections list, click on its name, then click on Delete.

To remove all functions from the Selections list, click on the Empty button.



Welcome to the magical, musical world of Evolution Audio Pro brought to you by leading UK
musical software developers, Evolution Electronics. Evolution Audio Pro provides a unique
combination of Digital Audio and MIDI recording, allowing you to make the most of your

musical ideas. Its user friendly, graphical interface ensures a fast learning curve, leaving you
to concentrate on the most important thing of all; making great music!

It is strongly recommended that you follow the step by step tutorials for Evolution Audio Pro
to familiarize yourself with the software.

What is Evolution Audio Pro?

Evolution Audio Pro Tutorials Full Tutorial guide.
Menus Help on menu items.
Windows Explanation of each editing window.
Keyboard Shortcuts "Power User" short cuts!
Glossary Fast Access to all topics.
Technical Support Support details.
Evolution Product Range Other Evolution products



Copy
Copies the selected items to the Clipboard.

See also:
Cut, Paste.



Cut
Copies the selected items to the Clipboard and removes them from the song.

See also:
Copy, Paste.



Delete Events...
Allows you to delete one or more events. It displays a Dialog where you choose which types 
of events are to be deleted, and the Scope of the change (for Notes and Polyphonic After 
touch).

If you are deleting Controllers, there are 128 of them to choose from, including Volume, Pan, 
Data Entry etc. Set the Controller Scope to be All or Specific. If deleting a specific 
Controller, use the combo box to choose the one you want to delete.



Delete...
This allows you to delete a file on disk. The File Dialog is displayed and you can choose a 
particular file type if you only want to look at one type of file.



Delete Identical Events
Allows you to delete events which start at the same position and are identical in all respects.

When this is called from the Track Window only the selected pattern(s) will be treated. If you 
have not selected any patterns, all patterns on the selected track will be treated.

If you call it from an editing window (e.g. Piano Roll or Event) you can define which events 
are treated. If you select a number of events, only those events which are selected will be 
treated. If you have not selected any events, all events will be treated.



Describe Clipboard...
Informs you what data, if any, is currently stored on the Clipboard.



Devices...
If your computer has any MIDI interfaces installed, they will show up in the Devices Dialog. 
You can choose which ones to use by clicking on their names. A device is in use if it is 
selected (white text on a black background). Note that Inputs and Outputs are treated 
separately, so you can, for example, turn off the MIDI Out on the MPU-401 but still use its 
MIDI In.

The devices in use will be shown in the various selectors used in other parts of the program, 
such as the Metronome Dialog and Track Columns.



Select Drum Columns...
Displays a Dialog where you can choose which of the columns are displayed in the Drum 
Window. For example, if you prefer to see Drum Names but not the Channels and Notes they
assigned to, turn on the Drum Name switch and turn off the Channel and Key switches.



Drum Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

To get to the furthest extent of a zoom, hold down the Control key while clicking on a zoom 
button.

Toggle Switches

Speaker Switch - enable sending of selected hits to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected hit.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Selector

Determines the resolution of the Hit Display. This value is also used as the step advance 
amount in Step Time entry.

Displays

1. The Drum Display shows the name of each drum and various settings associated with it. 
You can choose which settings are visible by changing which Columns are visible. Click on 
any of the column headings and the Select Drum Columns Dialog will be displayed. Here you
can turn columns on and off as required.

To the right of the columns is the Divider. You can drag this left and right so that some or all
of the columns are obscured by the Hit Display.

2. The Time Line shows the bars and beats currently being displayed. The number of beats 
per bar depends on the Time Signature - this can change if there are Time Signature 
changes defined in the Conductor Window. By clicking on the time line while holding down 



the CONTROL key, the Play Position will jump to the mouse position.

3. The Information Line shows detailed information about a selected hit. You can adjust 
these values with the mouse.

To the right is the name of the current Kit. When the program loads, the GM.DRM Drum Kit 
file loads automatically. This contains the General MIDI Kit.

4. The Hit Display is a grid where notes are shown as coloured LEDs - based on the drum 
machine layout of a row of LEDs which indicate hits. Here, however, different colours are 
used to indicate velocity. The possible colours are: Red, Purple, Blue, Green, Dark Cyan, Dark
Grey, Grey, Light Grey. If a hit is Red, it is at or above the Velocity setting for that drum. If it 
is Purple, it is at or above 10 below the Velocity setting. Each colour change represents a 
further reduction of 10.

Drum Settings

Name Can contain up to 20 characters.
Ch MIDI Channel.
Key MIDI Note associated with this drum.
Vel MIDI Velocity of hits when entered with the large Drum Stick.
Len The length in ticks of the note created when a hit is entered.

Drum settings can be changed directly with the mouse or in the Drum Settings Dialog. If you
want to give a drum a different Name, double click on it and the Drum Settings Dialog is 
displayed. Here you can type the new Name and change any of the settings which appear in 
the Drum Columns. You can also rename the Kit. When you change the Key or Channel of a 
drum, a warning is given if that Key-Channel combination is already in use by another drum. 
It is possible to define a Kit which uses all 16 Channels, and with the same Key used on 
different Channels e.g. E1 used on Ch10 and Ch11 to play Snare Drums on two different 
patches.

If you decide to use more than one Channel (in case more than one synth or synth patch is 
being used for drum sounds), set the channel of the track containing the drum patterns to 0 
so no rechannelization occurs when MIDI is sent.

If you click once on a drum's Name, you can move it up or down to a new position by 
dragging it with the mouse. This makes it possible to change the order of the drums to put 
them in a preferred order, e.g. to put all the Toms together.

Drum Buttons

Mute Prevents any MIDI data from being sent by a drum.
Solo MIDI data will be sent from the soloed drum ONLY. All other drums are muted. You can
still click on the drum buttons to turn muting off if you want to hear other drums as well as 
the soloed one. When you click on a solo button, the statuses of all the mute buttons are 
stored, so that when solo is turned off the mute buttons return to their previous settings. If 



you then solo the SAME drum the statuses of the mute buttons return to what they were 
when the drum was soloed. If you solo a DIFFERENT drum to last time, all mute buttons are 
turned on.

Selecting Drum Hits

You can select hits with either of these two methods:
1. Click on a hit - it turns black to indicate selection. Click on another one and that 

becomes the selected hit. If you hold SHIFT and click on a hit you can toggle its status 
between selected and normal. By using SHIFT clicking you can select several hits.

2. With the left mouse button click on a part of the Hit Display where there isn't a hit. 
Any selected hits become deselected. While still holding down the left mouse button, drag 
down and to the right, enclosing hits in the dotted 'drag rectangle' as you go. Release the 
mouse button. The hits inside the drag rectangle become selected. This method is called 
lassoing.

When one hit is selected detailed information about it is given in the Information Line. You 
can use the Up and Down arrow keys to move selection to adjacent hits.

Using the Edit, Options & Procedures functions

When using functions from the Edit and Options menus, whether hits are affected depends 
on their selection states. If you have selected one or more hits, ONLY those events will be 
affected. If no hits are selected, ALL hits will be affected. Remember though, that in the 
Options Menu functions the Scope setting may exclude some of them.
One method of copying one or more hits is to select them and use the Copy function (Edit 
Menu) to place a copy of them on the clipboard. You can then Paste them into the pattern at 
the current Play Position.

Moving and Copying Drum Hits

Selected hits can be moved and copied. Click on any one of them and drag to a new position
then let go of the mouse button. If you hold down the CONTROL key before you click, a copy 
of the hits will be made at the new position, leaving the originals intact. The newly copied 
hits then become the selected ones.

Functions Menu

Add Drum Adds a new drum at the bottom of the list.
Delete Drum Deletes the selected drum from the list.
Delete All Drums Deletes all drums in the list.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool 
Selector. Move the mouse until the one you want is highlighted. Let go of the right mouse 
button - the selector disappears and the mouse cursor changes to the new shape.



1. The Arrow is at the top left so you can change back to it quickly - click the right button 
and release immediately - there's no need to drag.

2 & 4. The Drum Sticks are used to enter new hits. The large stick enters a hit at the 
Velocity setting for that drum. The small stick enters a hit at a velocity 10 less than the 
Velocity setting. These two sticks therefore allow the entry of two levels of velocity, which 
can be regarded as normal and accented hits. If a stick clicks on an existing hit, it changes 
that hit's velocity.

3. The Eraser is used to delete hits. Click on a hit with the eraser and it disappears. If you 
click on one of a group of selected hits, all the selected hits are deleted.

5 & 6. Velocity Modifiers - The Up arrow increases the velocity of a hit by 10. This would 
make a purple hit red. The Down arrow decreases the velocity of a hit by 10. This would 
make a purple hit blue.

Step Time Entry

The Step Switch must be in the ON position. Notes arriving at MIDI In are recorded at the 
current Play Position with a length determined by the Grid setting. When you release the 
notes on the MIDI keyboard the Play Position advances by the same amount. To advance the 
Play Position without entering a note, press the space bar.

Using the PC Keyboard

The top row of keys on the computer keyboard can be used to play drums. The key on the 
far left plays the selected drum (the one whose name is highlighted) and the next one plays 
the drum below and so on. This makes it possible to play any set of drums simply by 
changing which drum is selected.

You can also use the keys in step time entry. The Play Position doesn't advance 
automatically, but stays in the same place to make it easy to enter successive hits at the 
same position. Press the space bar to advance the Play Position.

The Note and Velocity of a selected hit can be changed by MIDI input or the keys.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

See also:
General Window Information, Conductor Window.



Edit Menu
The Edit Menu contains the following Menu Items:

Undo
Redo
Copy
Cut
Paste
Clear
Select All
Describe Clipboard...



Editors Window
Each button opens a particular window. If that window is already open, it moves to the top of
the pile. If it is minimized, it is restored.

1. Track

2. Piano Roll

3. Event

4. Score

5. Drum

6. Conductor

7. Notepad

8. Mixer

9. Keyboard

10. Lyrics

See also:
General Window Information, Keyboard Shortcuts.



Event Window
Toggle Switches

Speaker Switch - enable sending of selected notes to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected note.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Insert an event of the type shown in the Ins Type selector.

Delete the selected event(s).

Make an identical copy of the selected event.

Selectors

Note Length - used in conjunction with the Insert button and in Step Time entry.

Choose the type of event to be added when the Insert button is pressed.

Use the Display Filters to specify which event types are shown. In this example any Notes, 
Program Changes and Pitch Bend will be shown.

The last three column headings change depending on what type of event is first in the list, 
or if any are selected, the type of the first selected event. In this example they are 
describing the Key, Velocity and Length of a note.

You can use the mouse to directly change the values in these columns, plus the event 
position.

Each type of event is shown in a different colour: the colours are the same as those used in 
the Piano Roll Window's Velocity Display.



During playback the left hand column shows a moving arrow which points to the events as 
they are played. If you click in this column while holding down the CONTROL key, the Play 
Position will jump to the mouse position.

Selecting Events

You can select events with either of these two methods:
1. Click on an event's name - it turns black to indicate selection. Click on another one 

and that becomes the selected event. If you hold SHIFT and click on an event you can toggle
its status between selected and normal. By using SHIFT clicking you can select several 
events.

2. Click on an event's name - any selected events become deselected. While still 
holding down the mouse button, drag up or down, selecting more events as you go. Release 
the mouse button when you have selected all you want.

To deselect all selected events, click in the left hand column.

Using the Edit, Options & Procedures Functions

When using functions from the Edit and Options menus, whether events are affected 
depends on their selection states. If you have selected one or more events, ONLY those 
events will be affected. If no events are selected, ALL events will be affected. Remember 
though, that in the Options Menu functions the Scope setting may exclude some of them.
To copy one or more events select them and use the Copy function (Edit Menu) to place a 
copy of them on the clipboard. You can then Paste them into the pattern at the current Play 
Position.

System Exclusive Editor

This allows you to edit directly the contents of a System Exclusive message. You can move 
the text caret around and type in new values in hexadecimal. To call it up, double click on 
the name of a Sysex event.

Step Time Entry

The Step Switch must be in the ON position. Single notes and chords arriving at MIDI In are 
recorded at the current Play Position with a length determined by the Note Len setting. 
When you release the notes on the MIDI keyboard the Play Position advances by the same 
amount. 

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

See also:
General Window Information, Piano Roll Window.



Step by step help on all the features of EVAP

Getting Started.
The Arranging Tutorial
The Drum Editor Tutorial
The Piano Roll Editor Tutorial
The Event Editor Tutorial
The Score and Lyrics Editors Tutorial
The Conductor Tutorial
The Mixer Tutorial
The Recording Tutorial
The Chords Track Tutorial
The Fast Menu Tutorial



Evolution Audio Software Specifications

256 Track MIDI sequencer Event List Editor
Audio Wave Support Drum Editor
16 Track Mixer with MU Meters 16 Built-In styles
Piano Roll Editor Virtual Band Facility with Jammer
Score Editor and Printing On-Screen Keyboard



Evolution is a premier manufacturer of MIDI and Audio products for the PC.    Evolution offers 
a wide range of hardware and software with the emphasis on affordable music products for 
the novice and professional PC Musician alike. Expand your musical horizons with the 
exciting range of Evolution products, all designed with ease of use in mind.

Hard Disk Recording Software
Keyboards
Software Package
Ordering Information



Fast Menu Window
This window allows you to choose up to ten menu items and have them visible at all times. A
single mouse click executes the function instead of going via the Menu Bar. Each menu item 
is represented by a button. Pressing that button executes the menu item. You can change 
which menu items appear in the Fast Menu Window in the Configure Fast Menu Dialog.

See also:
General Window Information.



File Menu
The File Menu contains the following Menu Items:

New
Open
Save Song
Save...
Save As...
Merge Song....
Merge MIDI File...
Delete...
Quit

File Formats

The contents of each type of file are as follows:

Song (.SNG)

Tracks used.
Patterns used.
Timebase.
Tempo & Time Signature.
Song Start Time & Frame Format.
Left & Right Locators.
Lyric channel.
Notepad.

Pattern (.PAT)

Contents of pattern.

Drum Kit (.DRM)

Contents of Drum Kit.

MIDI (.MID)

Standard MIDI File format, Type 0 or 1.

Definitions (.DEF)

Contains values from the Options Menu items:

Preferences...
Metronome Settings...
Devices...
Mixer Settings...
Audio System Settings...
Lyric Font...

Also, the current drum kit file plus the Port-Channel-Patch List connections and the 
knowledge of which Patch Lists are in use.



The file DEFAULT.DEF is saved each time you Quit from the program, and loaded the next 
time you run it, so these settings are preserved between sessions.

Window Layout (.WND)

For each Window and the Program Window
Size and position.
Whether maximized or minimized.

Transport Window
Auto Return.
Record Mode.
Toggle switches.

Track Window
Visible Columns.
Horizontal & Vertical Zoom levels.
Snap settings.

Piano Roll Window
Horizontal & Vertical Zoom levels.
Grid resolution.
Speaker, MIDI, & Step switches.

Event Window
Note Length.
Insert Type.
Speaker, MIDI & Step switches.
Display Filters.

Score Window
Resolution.
Note Length.
Speaker, MIDI & Step switches.
Contents of Score Settings Dialog.

Drum Window
Zoom level.
Grid Resolution.
Speaker, MIDI & Step switches.
Visible Columns.

Conductor Window
Zoom Level.
Snap.

Fast Menu Window
Menu Items.

The file DEFAULT.WND is saved each time you Quit from the program, and loaded the next 
time you run it, so these settings are preserved between sessions.



General Window Information
Functions Menu

Displays a pop-up menu containing functions relevant to that window.

Adjusting Values

The left and right mouse buttons are used to change the values displayed in a window as 
follows:

Left Button -1
SHIFT + Left Button -10 (-12 for notes = one octave)
Right Button +1
SHIFT + Right Button +10 (+12 for notes = one octave)

Holding down a mouse button causes the values to change repeatedly until the limit for that 
particular value is reached. To move quickly through the values without using the SHIFT key, 
hold down the opposite mouse button to the one you started with. For example, click on the 
left button to reduce a value in steps of 1. Without taking your finger off the left button, hold
down the right button - the values will start to reduce in steps of 10 (12 for notes). Take your
finger off the right button and the values revert to reducing in steps of 1.



Getting Started.
What is Evolution Audio Pro?
EVAP Highlights
What you need
Sound Cards
Testing the sound card
The MIDI Interface
Sequencer basics
Digital Audio basics
CD sound
Harry Nyquist and his theorem
Direct-to-disk recording
Setting up your equipment
Selecting the MIDI Interface

What is Evolution Audio Pro?

Evolution Audio Pro is a powerful MIDI sequencer with integrated digital audio playback 
facilities. You can record and arrange music for a MIDI synthesizer and add digital audio 
patterns such as vocal rifts, drum loops, ambient background sounds and so on.

EVAP also has a Chords track so you can add instant accompaniments in a variety of styles 
to your music. This is very easy to use and can save hours of arranging time.

EVAP supports up to 256 tracks. If you don't use a Chords or Audio track, you can have 256 
MIDI tracks. Using a Chords or an Audio track will reduce the number of available MIDI tracks
to 255 or 254. But even seasoned sequencer users are unlikely to use them all! Using EVAP 
is like having your own band or orchestra - except you have much more control over your 
music with EVAP than you have over a band!

You can record audio in sync with EVAP by purchasing the 2 Track Audio Amplitude Late 
program.
EVAP Highlights

As its name suggests, EVAP is a professional piece of software with many high-end features. 
However, because of its design and intuitive user-interface it's easy to use by professional 
musicians and beginners alike. Here are just a few of its many features:

* Intuitive Track window where you can copy and drag music patterns to create a song.

* Audio track where you can add audio parts to a MIDI arrangement.

* Chords track to let you create instant accompaniments with a few mouse clicks.

* A programmable Mixer which shows Controller information present in the tracks and which 
allows you to perform real-time mix downs.

* A grid-based Drum editor to help create and edit drum tracks.

* An easy-to-use Piano Roll editor which displays note velocity and MIDI Controller data.

* A multi-stave Score editor where you can see, edit and print your music in traditional 



notation.

* A Lyrics window which displays lyrics on screen in time to the music.

* A graphic Conductor window where you can quickly make adjustments to the time and key 
signatures.

* Full support for Standard MIDI Files.

* Patch Lists which let you select sounds by name rather than number.

* Support for multiple MIDI outputs - you can channel some tracks to your sound card's FM 
output, some to its Wave table sound and others to a MIDI interface.

* Comprehensive synchronization including MIDI Clock, MIDI Timecode and SMPTE, allowing 
you to synchronize EVAP to many other music devices.

EVAP has many more powerful features which you'll soon become familiar with, all fully 
explained in this manual.

What you need

To run EVAP you require the following:

* A 386 IBM PC or compatible running at a minimum speed of 33 MHz, preferably faster.

* Windows 3.1 or Windows 95.

* 4Mb of RAM with Windows 3.1, 8Mb of RAM with Windows 95.

* 5Mb of hard disk space for the program plus additional hard disk space to store digital 
audio files. CD-quality stereo sound uses 10Mb of hard disk space per minute although you 
don't have to use such high quality if you don't need it. See the section on Digital Audio 
basics for more information

* A VGA resolution monitor or better. A Super VGA display will let you see more of the 
contents of each window and it's easier to work with more than one window at the same 
time.

* A MIDI interface or PC sound card with a MIDI interface. If you want to use EVAP's digital 
audio playback facilities, you will also need a sound card which supports digital audio. See 
the sound card section for more information.

* A MIDI input device to record MIDI data. A keyboard is the most popular device but you 
could use a MIDI guitar or MIDI wind controller. Evolution produces a small keyboard 
specifically designed for use with computers. Ask Evolution for more information (contact 
details are at the front of the manual in the Technical Support section). Even without an 
input device, you can still enter music into EVAP through step-time note entry and with the 
program's Keyboard.

* A MIDI output device in order to hear the music. If you are using a standard MIDI interface 
this will be a synthesizer, sound module or sampler. If you have a sound card, you can use 
its built-in sounds.



Sound Cards

There are dozens of PC sound cards on the market. EVAP will work with any Windows-
compatible card, that is one which has drivers for Windows. You will see these in the Drivers 
section of the Control Panel and be able to select them in the MIDI Mapper in the Control 
Panel. All modern sound cards are compatible.

EVAP works with MIDI and audio data so there are two aspects of the sound card to consider.
Most modern sound cards have a set of on-board sounds which can be used to play the MIDI 
parts. Most cards, too, also support digital audio. In order to work with EVAP, the card must 
have separate drivers for MIDI and audio. Again, all modern ones do.

Some older cards do not support digital audio. They will still work with EVAP providing they 
have Windows drivers but you will not be able to use EVAP's digital audio playback facilities. 
Also, some older cards use the same device driver for both audio and MIDI which will not 
allow you to play MIDI and audio simultaneously in EVAP.

Testing the sound card

Make sure your sound card is installed correctly and the drivers are set up properly before 
using EVAP. The software which comes with the sound card should include routines to test 
the card. You must make sure it is running correctly under Windows, not just DOS.

An easy way to test the card is with the Media Player which you will find in Windows' 
Accessories Program Group. Look in the Device menu and you should see MIDI Sequencer... 
and, if your card supports digital audio, Sound...

Try playing the CANYON.MID file which Windows installs automatically in the Windows 
directory. Then try playing a .WAV file. Again, there should be some in the Windows directory.

If either of these items is missing from the Device menu it means the drivers have not been 
loaded. Go back to the Drivers Control Panel and install the correct drivers. Refer to your 
sound card's manual and the Windows Users' Guide for more information.

The MIDI Interface

Many sound cards have a built-in MIDI interface which is accessed from a joystick connector 
on the backplane of the card. To use it you need a MIDI adapter. One end plugs into the 
joystick socket and the other terminates in MIDI plugs or sockets which you connect to your 
MIDI equipment. Some sound card packs include the adapter but many of the cheaper ones 
do not.

There are also several dedicated MIDI interfaces available. Many are on plug-in cards which 
are fitted and installed into the PC just like a sound card.

There are also external MIDI interfaces which connect to the PC's printer port or serial port. 
You can install them without opening up your PC and they are ideal for use on portable PCs. 
You still have to install driver software for them. Some have a Thru socket which enables you
to plug in your printer and use it without removing the interface. Other's don't.



Sequencer basics
If you're completely new to computer-based sequencing, read this otherwise you can skip to 
the next section.

A sequencer is the computer equivalent of a multi-track audio tape recorder - but with 
several important differences. On a traditional multi-track machine, each instrument will 
typically be recorded on its own track. To construct a song, each part has to be recorded 
from the beginning through to the end.

A MIDI sequencer such as EVAP has many more tracks than any multi-track recorder it's 
possible to build. Instead of forcing you to work from the beginning of a song to the end, 
EVAP uses patterns which enables you to assemble a song from many different phrases, 
dropping them into the song wherever you wish. This is infinitely more flexible and is the 
way many composers think and work.

Another important difference lies in the type of data the systems use. Multi-track recorders 
use audio data, sequencers use MIDI data which is simply lists of numbers. Every MIDI event 
has a corresponding set of numbers so you can alter any MIDI event simply by changing the 
numbers.

You can, for example, adjust the volume of a single note, add pitch bend to it or even change
its sound completely. These things are impossible to do with a multi-track. You can change 
the tempo of a piece without changing the pitch and vice versa - another multi-track 
impossibility.

In short then, a sequencer gives you an enormous amount of control over every aspect of 
your music.

There's one very important point to remember - a sequencer stores details about a MIDI 
performance such as which keys where pressed, how hard, how long they were help down 
for, when the pitch bend wheel was moved and so on. It does not store the sounds used, 
rather it uses a system of Bank Select and Program Change messages to select sounds on 
the playback instrument.

This is actually very helpful as it means you can also change the sound used by a music 
part, changing a flute line tom a trombone or set of bagpipes. Try to do that with a multi-
track!

Digital Audio basics

If you're familiar with the principles of digital audio you can skip to the next section.

Digital audio recording is the process of converting audio data - sound - into digital data, 
essentially a list of numbers, which can be stored on a computer. The device which does this
is built into most sound cards and is known, quite helpfully, as an Audio-to-Digital converter. 
This is often abbreviated to ATD or just AD.

To convert the digital data back into sound, the card uses a DA converter. No prizes for 
guessing what this means.

To capture sound, the AD converter takes a sample of it so-many times each second. This is 
known as the sample rate and it's measured in kHz or so-many thousand samples per 



second. The higher the rate, the more samples the AD takes and the more accurate the 
digital representation of the sound will be.

The sampling resolution is the accuracy or fineness of the measuring scale used to store the 
sound and is measured in bits. There are two resolutions currently in common use - 8 bits 
and 16-bits - and most modern sound cards support both. Some of the latest generation of 
sound cards have a higher resolution, 18 bits, which should result in even higher quality, 
professional sound reproduction.

To give you an idea of the relevance of the sampling resolution, imagine two people are 
building a house. One is using a measuring stick marked to the nearest foot. The other has a
stick marked to the nearest inch.

The one using the finer scale will build a more accurate house and although the other's may 
not fall down, it will certainly be a bit rough around the edges. That's how we perceive sound
recorded at a lower sample resolution.

CD sound

CD quality audio is recorded at a sample rate of 44.1kHz with 16 bit resolution. Many 
Multimedia programs use a lower rate such as 22.05kHz or even 11.025kHz, and many use 8
bits. This is often quite adequate if the sound is played through inexpensive PC speakers but 
you would almost certainly be able to tell the difference if it was played through a good hi fi 
system.

Harry Nyquist and his theorem

A little bit of theory here. Mathematician Harry Nyquist developed a sampling theorem which
says, roughly, that in order to capture any sound accurately you must sample it at twice its 
highest frequency. (To be strictly accurate, it's actually about 30 to 50 percent of the sample 
rate but half is near enough for most folk who aren't recording engineers.)

The average human ear can recognize frequencies up to about 15kHz. Even the most 
sensitive ears rarely sense anything over 20kHz which is why CDs recorded at 44.1kHz 
sound so clear.

Bear Harry's theorem in mind when you're recording. You may be able to use a lower 
resolution particularly if you're recording speech. However, if you record music at a lower 
resolution and it doesn't sound very good you'll know why!

Direct-to-disk recording

One minute of CD-quality sound requires 10Mb of storage space. Clearly it's impractical, not 
to say expensive, to store this in RAM. So it's not, it's saved to disk. The saving has to be 
done on the fly, while the sound is being recorded, and you need a reasonably fast hard disk 
if the data is to be saved accurately and played back without a glitch.

Most modern disks are well up to the job but some older ones may cause a glitch, especially 
if they are running in a slow PC. Just something to bear in mind.

EVAP 



When you record digital audio using EVAP it saves it direct-to-disk xxx

Setting up your equipment

Make sure the MIDI interface or sound card and EVAP are correctly installed. If you are using 
an external MIDI keyboard connect it's MIDI Out to the interface's MIDI In.

If you are also using the sounds on the keyboard, connect its MIDI In to the interface's MIDI 
Out. If you are using the sounds on a sound card this is not necessary.

If you want to use a keyboard for recording but a MIDI sound module for playback, connect 
the module's MIDI In to the interface's MIDI Out.

If you want to use EVAP's audio playback facility, make sure the sound card's audio output is 
connected to a pair of speakers.

Selecting the MIDI interface

VERY IMPORTANT

You must tell EVAP which MIDI devices you want to use otherwise so after starting the 
program, before you do anything else, select Devices... from the Options menu. The 
window will show which Input and Out MIDI devices EVAP has recognized.

If you cannot see your sound card or MIDI interface here it means the drivers have not been 
installed so check the card or interface's documentation and install the drivers. When the 
drivers are properly installed you will see them in the Drivers Control Panel and in this 
window.

You must select at least one Input and one Output device by clicking on them to highlight 
them. You can select any or all devices. If you select more than one Input device, EVAP will 
accept input from them all during recording.

If you select more than one Output device, you can assign any of them to any of the tracks 
during playback, allowing you to send music lines to different MIDI devices. There's more 
about this later in the manual.
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Hard Disk Recording Software
Do you wish to record audio such as vocals or drum loops, play back some video footage and integrate it 
with your MIDI sequence? Then Samplitude is the obvious solution.

Samplitude Hard Disk Recording Software

Samplitude is a hard disk recording software that runs on an PC for sampling, hard-disk recording and 
sample processing of the highest quality. It is user friendly, and has been written with special code so that 
it runs completely in sync with our Evolution Software. Evolution Audio Pro and Samplitude will share the 
same start/stop - fast forward/ rewind - record,zoom in/out commands.
This ensures complete integration of Audio and MIDI on the same PC screen.

There are 4 versions of Samplitude

- Samplitude-Lite (2 Tracks, Virtual Wave Editing, Sample manipulations)
- Samplitude-Multimedia (4 tracks, virtual editing, MIDI/AVI integration, Track Bouncing,...)
- Samplitude-Pro (8 tracks, Record while Play, Resampling/Time-Stretching, MIDI-Sample-Dump...)
- Samplitude-Studio ( up to 16 tracks, ext. Sync., digital filters, dynamic functions...)

:

Features of Samplitude:

Samplitude-Lite/Multimedia has the following features:

- real hard disk recording/playback with all Windows compatible 16 bit sound
    cards
- virtual projects with up to 4 tracks (2 tracks in Lite version).
- support of all 16 Bit sound cards with sampling rate up to 48 kHz
- support of mono/stereo projects in recording and playback
- support of Ram- or hard disk projects
- "Volume Rubberbands" for realtime mix of    the virtual tracks
- Realtime cross fades in virtual tracks with various curves

- MIDI and AVI files can be linked to Samplitude, qualified for film music
    composition, MIDI/audio synchronization ... 
- Direct synchronization with MIDI sequencers "Evolution MIDI", "Evolution Audio" and "Evolution Audio 
Pro"
- Realtime surround effect 
- physical sample processing in high speed and high quality (e.g. cutting,
    normalization, fading, cross fading, echo, hall effect, filter...)
- virtual projects for non-destructive editing, sample objects can be placed,

    shifted (displaced) and manipulated (time-line)
- ranges of various projects (RAM and HD) can be combined into virtual projects,
    e.g. cuttings of various records
- fade-in, fade-out and volume of every object can be produced in real time (non-
    destructive) and easily manipulated by "handlers"
- sophisticated window techniques, unlimited number of projects
- several windows per project, e.g. for loop search
- special mode for automatic loop optimization
- ranges and cursors can be manipulated during playback

- auto scroll mode while playing



- all cursors and ranges can be saved.
- very long samples can be displayed quickly
- various snap functions, e.g. for objects, bars, ranges...
- wave file import and export

Samplitude-Pro has following extensions:

- virtual projects can have up to 8 tracks (8 Mono or 4 Stereo)
- Record while Playing if the sound card(s) supports this
- MIDI sample dump for sample transferring with MIDI samplers

- easy Resampling / time stretching / pitch-shifting
- track bouncing for converting virtual projects into a physical file (Samplitude
    project or wave file); more than 8 tracks can be combined.

Samplitude-Studio has following extensions:

- virtual projects can have up to 16 tracks (16 Mono or 8 Stereo)
- Support of up to 4 sound cards for real 8 outputs
- ext. Sync via SMPTE/MTC/MC (Slave) or MC/MTC (Master)
- Scrubbing and Varipitch while playback

- Runs in multitasking with MIDI-Sequencers, e.g. Evolution Audio Pro
- High quality digital filters (graph. EQ, param. EQ) with realtime preview
- Dynamics Compressor/Expander/Noise-Gate with realtime preview
- Convolution for enhanced effects like reverb, echo and filter...

Hardware needed
 
To use Samplitude you mainly need at least a PC with Windows 3.1 and 4 Mb RAM and a 386 processor.
To record and playback audio data you will need a 16 bit sound card with Windows driver.

For "Record while Play" you need a sound card, which can be opened for input and output at the same 
time or two sound cards with two drivers, one for playback, one for recording. (also known as a Duplex 
Sound card)
For hard disk recording an adequate hard disk memory will be needed (one minute recording in CD 
quality requires about 10 Mb), together with a fast 386 processor or better, a 486 one.
For realtime filter-preview and volume rubber bands on more than 4 tracks you need a 486/66 or Pentium 
processor. 

To use MIDI sample dump or a connection with MIDI devices you must have a Windows-compatible MIDI 
interface.
For external Sync via SMPTE you need a special SMPTE interface, for Sync via MIDI-Timecode or MIDI-
Clock you can use any Windows compatible MIDI interface.

Typical number of tracks (Mono) in virtual projects:
386/40 with AT-harddrive: 4 tracks 32 KHz
486/66 with AT-harddrive: 4 tracks 44 KHz, 6-8 tracks 32 KHz
486/66 with SCSI-harddrive, PCI-Controller: 6-8 tracks 44 KHz

Pentium with PCI-SCSI-disks: 12 tracks 44KHz , 16 tracks 32 KHz
Using stereo tracks instead of 2 mono tracks increases the performance.
For maximum track number please raise the buffer size for VIPs in menu "Setup > System"!

Return to Products Page





Help Menu
The Help Menu contains the following Menu Items:

Contents
Menus
Windows
Keyboard Shortcuts
How to Use Help
About Evolution Audio Pro...
Memory Check...



Hide Editors
Hides the Editors Window. When the Editors Window is hidden, it changes to Show Editors.



Hide Fast Menu
Hides the Fast Menu Window. When the Fast Menu Window is hidden, it changes to Show Fast
Menu.



Hide Transport
Hides the Transport Window. When the Transport Window is hidden, it changes to Show 
Transport.



How to Use Help
Displays the built-in information on using the MS Windows Help system.



Action Key(s)

      
Return to Zero Home
Go to end of last pattern End
Metronome On / Off M
Cycle On / Off C
Follow On / Off F
Conductor On / Off O
Edit Solo On / Off E
Synchronization On / Off S
Punch In and Out On / Off P
Rewind Left Arrow
Forward Right Arrow
Stop (+ Enter a Rest in Step 
Time entry)

Space

Play Return / Enter
Record +
Jump to Left Locator L
Jump to Right Locator R

Quantize directly (using 
current settings)

Q

Next Page (Score Print 
Preview)

Pg Up

Previous Page (Score Print 
Preview)

Pg Dn

Change Note Len Setting 
(Score Window)

1 to 7, D, T, N

Play Drum Sounds (Drum 
Window)

All keys on the top row

Display Track Window F2
Display Piano Roll Window F3
Display Event Window F4
Display Score Window F5
Display Drum Window F6
Display Conductor Window F7
Display Notepad Window F8
Display Mixer Window F9
Activate Menu Bar F10
Display Keyboard Window F11
Display Lyrics Window F12

Go to next event (Edit 
Windows)

Down Arrow

Go to previous event (Edit 
Windows)

Up Arrow



Insert Event (Event) Insert
Delete / Clear Delete
Undo Alt + Backspace or Ctrl + Z
Redo Shift + Alt + Backspace or Ctrl + A
Copy Ctrl + Insert or Ctrl + C
Cut Shift + Delete or Ctrl + X
Paste Shift + Insert or Ctrl + V

Open Ctrl + O
Save Song Ctrl + S

Transpose Ctrl + T
Change Velocity Ctrl + H
Change Lengths Ctrl + L
Quantize Ctrl + U
Move Events Ctrl + J
Change Timing Ctrl + I
Delete Events Ctrl + D
Thin Out Continuous Events Ctrl + N
Delete Identical Events Ctrl + Y
Reverse Notes Ctrl + R

Cascade Windows Shift + F5
Tile Windows Shift + F4
Close a Window Ctrl + F4
Next Window Ctrl + F6
Show / Hide Transport Bar Ctrl + F7
Show / Hide Editors Strip Ctrl + F8
Show / Hide Fast Menu Ctrl + F9
Play white notes on screen 
keyboard

Keys A- #

Play black notes on screen 
keyboard

Keys W-]

Transpose Down one octave (PC 
Keyboard Window) 

Scroll Lock

Transpose Up one octave ( PC 
Keyboard window)

Hold Down Shift Key



Keyboard Window
The Keyboard has three uses:

a) By clicking on it you can play/record notes and styles
b) It shows notes arriving at MIDI In.
c) By enabling the PC Keyboard button you can use the PC QWERTY Keys to actually 

record your own songs without having to plug in an external keyboard.

By using keys (A - #) and (W-]) you can play one and a half octaves of the keyboard. Holding
down the Shift Key whilst hitting a key will transpose the keys up an octave thus increasing 
the range of the screen-keyboard!

Hitting the "Scroll Lock" button will transpose the keyboard down one octave. This is useful 
for playing single fingered chords using the QWERTY keys.

To record your chord track in realtime using the screen keyboard take a look at the chord 
track tutorial

Toggle Switches

Single Finger Chord - when the Active switch is on, the chords are taken from the notes 
you play in the bottom octave of the keyboard instead of the Chord Sequencer. When 
Synchro is on, Single Finger Chord play will start as soon as you press a key in the bottom 
octave. When Hold is on the accompaniments will continue to play after all keys have been 
released - when it is off only the drums will play.

When you are playing Single Finger Chord from the external keyboard, the highest note in 
the bottom octave determines the chord root note. If you don't play any notes below it, the 
chord type is major (Maj), but if you hold down a black note the chord type is minor. Holding 
down a white note generates a 7th (7), while holding both a black and a white note plays a 
minor 7th (m7).

If you play the screen keyboard, the note the mouse clicks on defines the chord root, with 
the chord type being taken from whichever chord button is selected.

Play Mode Switches - determines how the keyboard responds when you play or click the 
keys with the mouse. In Free Play mode the keyboard acts like a normal keyboard. In Drum 
Play mode the keyboard generates drum sounds. Playright mode is designed to be used in 
conjunction with the accompaniments (from either the Chord Track or Single Finger Chord) - 
in this mode you can never play a wrong note - you can only Play Right! Chord Play mode 
generates chords from single key presses. The type of chord depends on which of the Chord
Buttons is selected.

Sus Switch - turns sustain on and off by sending a MIDI Sustain message.

The Octave setting can be used to raise or lower the pitch of the notes generated when you
play the keyboard with the mouse or from the external keyboard.

See also:
Track Window.    Realtime Chord    Recording



Keyboards
Music Creator
A    49 note mini keyboard with standard MIDI output, PC sound card lead and Keywest 
Software

Music Creator transforms your PC into a Music workstation. Simply connect the MIDI 
Keyboard to your Sound Card via the cable supplied, load the Keywest Music Software and 
begin to create music instantly.

Music Creator is a PC compatible MIDI Controller that connects to all PC Sound cards with a
MIDI Port (usually the same as the Joystick Port).

Music Creator uses General MIDI to access sounds on your PC sound card - you can access 
drums, guitars, horns, pianos and many more!

Never    played a musical instrument before? Music Creator enables you to play complicated 
chords with just one finger.

Choose from 16 different musical styles and jam along with a six piece "virtual band": you 
can even choose which instrument each band member plays.

Music Creator Pro
Full Size MIDI Keyboard and Sequencing Software
Music Creator Pro transforms your PC into a music Workstation. Simply connect the MIDI 
Keyboard to your sound card via the cable supplied, load the Evolution Audio Music 
Sequencer and begin to create music instantly.

Winner of the PC PRO Recommended and PC PLUS Gold Awards
Music Creator Pro consists of an MK-149 Keyboard and Evolution Audio Software.
(click on the product names for the specifications)
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Lyric Font...
Displays a Dialog where you can choose a font, whether it is bold or italic, and its size. This 
font is used in the Lyrics Window. Large text is useful if you want to sing the lyrics, while a 
smaller font is better for viewing the lyric sheet as a whole because more lines can fit in the 
window.



Lyrics Window
This window displays any lyrics present in your song or MIDI file. You can change the font 
type and size in the Lyric Font Dialog, which is called from the Options Menu.

During play each lyric event is highlighted when it is time for it to be sung. Many files 
contain words split into syllables, which helps you scan the word correctly while singing. 
When the play position is moved, the highlighting changes to show the position in the lyric 
sheet at that point in the song.

If you want to edit the lyrics, or enter your own, select the pattern containing the lyric 
melody and open the Score Window. Note that the Score Settings dialog allows you to define
the MIDI channel containing the lyric melody, to ensure the lyrics are shown in the right 
place.

See also:
Score Window.



Options Menu
é
The Options Menu contains the following Menu Items:

Preferences...
MIDI Settings...
Synchronization Settings...
Metronome Settings...
Mixer Settings...
Devices...

 Patch Lists...
 Audio System Settings...
 Wave Files in Use...
 Score Settings...
 Lyric Font...
 Select Track Columns...
 Select Drum Columns...



MIDI Settings...
Timebase defines how many ticks make up one beat. The larger the number, the shorter 
the time between each tick, and the more faithfully real time performances can be recorded 
and played back. However, the PC has to work harder at higher time bases, so if you don't 
need high precision, use a lower value.

Note that if all your patterns are quantized to 16ths, a timebase of 48 will still be 12 times 
finer than you're actually using (there are 6 MIDI clocks in a 16th note and the MIDI clock 
has a timebase of 24: 6 x (48/24) = 12).

Evolution changes its timebase to suit that of any Standard MIDI File (.MID) it loads, so you 
can open the MIDI Settings Dialog to see what timebase the file is set to.

Message Filters are a set of switches which determine the MIDI message types allowed to 
enter at MIDI In. Remember though that if, for example, you turn on the Pitch Bend filter, 
you won't be able to record any pitch bend!

Channel Filters are another set of switches which allow you to keep out MIDI messages, 
but here you can keep out all message types on any number of the 16 MIDI channels.

Thru Channel Messages is a switch which determines whether channel-based messages, 
such as notes and pitch bend, received at MIDI In are echoed to MIDI Out.

Thru Real Time Messages is a switch which determines whether timing messages are 
echoed to MIDI Out.

Reset Controllers on Stop means that when you stop the sequencer, Evolution sends a 
number of messages on each MIDI channel which do such things as centre pitch bend 
wheels, zero modulation wheels and turn off hanging notes.

Kill Notes on Cycle tells Evolution to turn off any notes which are currently being played 
when the Right Locator is reached (assuming the Cycle switch is on). It prevents unwanted 
notes hanging on when play jumps to the Left Locator.

Chase Events tells Evolution to make sure that when you move the Play Position, external 
MIDI instruments are told what all their settings should be at that point in the song - 
program change, pitch bend, modulation wheel etc. - so the song sounds right when you 
restart play.



Memory Check...
Tells you how many Kilobytes of free memory are available in the system.



Menu Items

Each Menu contains a number of items used to access various functions. Each item may act directly or 
call up a Dialog Box. Menu Items which are followed by three dots (...) call up a Dialog Box. Others act 
directly.



All you need to know about menu options in EVAP

File
Edit
View
Procedures
Options
Window
Help

Help for each Menu Item can be accessed directly by pressing F1 when the menu item is 
highlighted.



Merge MIDI File...
This allows you to load a MIDI file from disk and merge it into the song you are currently 
working on. The tracks of the MIDI file are placed at the bottom of the track list, so there's no
danger of them overwriting the existing tracks.

The tempo and time signature of the original MIDI file are not affected, so again there's no 
danger of losing the settings of the piece you are working on.



Merge Song...
This allows you to load a song from disk and merge it into the song you are currently 
working on. The tracks of the song being merged are placed at the bottom of the track list, 
so there's no danger of them overwriting the existing tracks.

The tempo and time signature of the original song are not affected, so again there's no 
danger of losing the settings of the piece you are working on.



Metronome Settings...
The Metronome Settings Dialog allows you to tailor the Metronome to your requirements. 
You can have a beep from the PC speaker and / or a click played on an external MIDI 
instrument.

If you use the MIDI option you can determine separately the notes used by the first beat of 
the bar and by the other beats, plus their velocities.

If you turn on the Record Only switch the metronome operates during recording only. Turn 
this switch off if you want to hear the metronome during playback.

The Count in Bars setting defines how many bars of metronome clicks will be given before 
recording begins.

See also:
Transport Window.



Mixer Settings...
The top two knobs (i.e. the red and blue ones) can have their use redefined. You can select 
from several message types and set the maximum and minimum values sent when you 
move the knobs.

The Dialog also contains the following switches:

Text Under Faders Three radio buttons are available:
Volume    the word Volume itself is displayed.
Track Names    the program checks the ports and MIDI channels of the tracks and displays 
the name of a track under the matching mixer channel for the appropriate port.
Patch Names    the program checks the ports and MIDI channels of the tracks and displays 
the name of a patch under the matching mixer channel for the appropriate port. This is 
taken from the patch list associated with that port-channel assignment.

MIDI Input to mixer This allows you to decide whether messages arriving at MIDI In move 
the controls.

Song to mixer This lets you decide whether MIDI messages in the song are sent to the 
mixer controls - if it is turned on the knobs and faders move in real time as the song plays 
the corresponding MIDI messages. They also move when you relocate the Play Position - the 
Chase Events feature in the MIDI Settings Dialog which sends the current values of volume, 
pan etc. via MIDI also updates the positions of the mixer controls. If the Song to mixer switch
is turned on part way through a song or MIDI File the controls update even if playback has 
been stopped.

Record mixer movements This switch enables recording of the movements of the knobs 
and faders. Other actions recorded are Flatten Mixer (flatten all the controls in the mixer), 
pressing a channel's Flat button (flatten all a channel's controls), and CONTROL clicking on 
an individual control to flatten it.
When playing back a recording of mixer moves which contains more than one MIDI channel, 
it is best to set the track's channel to 0 (no rechannelization) so the same channels are 
played back. If only one MIDI channel was recorded the track's channel can be assigned to 
that channel or left at 0, whichever is preferred.

Volumes Only This switch causes the mixer to display the Volumes and meters only. It 
allows you to see more mixer channels on screen at once as the space used by each channel
is much less.

See also:
Mixer Window.



Mixer Window
      

The Mixer contains a set of 16 MIDI channels for 
each MIDI Output driver in your system. Each 
channel contains a Flat button, a Volume slider, 
3 knobs, 2 switches and a meter. All except the 
meter can transmit MIDI data to your sound 
card or external synthesizer. Click on a control 
and move the mouse up or down (there's no 
need to move the mouse when you click on a 
button or switch).

Not all sound cards and synthesizers support 
Reverb and Chorus.

Pressing the Flat switch sets all controls on that
channel to their default positions. You can 
flatten a single knob or slider by clicking on it 
while holding the CONTROL key.

In addition to sending data via MIDI Out, the mixer can also respond to data arriving at MIDI 
In and to data contained in a song. The controls move in response to the same messages 
they are capable of sending, so the Volume faders move in response to MIDI Volume data 
and so on. You can decide how the mixer responds with switches in the Mixer Settings 
Dialog.

If you press the Snapshot button the positions of all the knobs and faders are sent via MIDI. 
If you are recording and the 'Record mixer moves' switch is turned on, these settings will be 
recorded. It is a good way of storing the settings for a song once you have set them up.

If you press the Auto Size button the window is resized so it is the exact width and height of 
one set of 16 channels. If the Volumes only switch in the Mixer Settings Dialog is on, it is 
accounted for.

To flatten all channels, press the Flatten Mixer button.

The buttons across the top of the window allow you to go directly to a port without using the 
vertical scroll bar. The highlighted button shows which mixer is at the top of the window.

See also:
General Window Information.



Move Events...
Allows you to change the start positions of one or more events. It displays a Dialog where 
you set the number of ticks by which the events will be changed (either Forward or Back).



MK-149 Specifications

49 Full Size Keys (Velocity Sensitive) 6 Program Memories
Pitch Bend Wheel 3 Digit LED Display
Modulation Wheel (assignable) Standard MIDI Connection
Transpose Includes Connecting cable for Sound card
Octave Shift Standard sustain pedal socket
Program and Bank Change (MSB & LSB)



New
This removes the current song from memory - use it when you want to start a new song.



Notepad Window
This allows you to include textual information with each song. The contents of the Notepad 
are saved in the song file and displayed automatically when a song is loaded.

When you type, word wrapping happens automatically, and you can use the Copy, Cut, 
Paste, Clear, and Undo functions from the Edit Menu. If you use Copy or Cut to place text on 
the clipboard, you won't lose any patterns or events already there.

See also:
General Window Information.



Open
Loads a file from disk. The following file types are allowed:

Song (.SNG)
Pattern (.PAT)
Drum Kit (.DRM)
MIDI File (.MID)
Definitions (.DEF)
Window Layout (.WND)

Each file type has a corresponding radio button on the right side of the Dialog. If you click on
one of these the directory will show files of that type.



Procedures Menu
The Procedures Menu contains the following Menu Items:

Transpose...
Change Velocity...
Change Lengths...
Quantize...
Move Events...
Change Timing...
Delete Events...
Thin Out Continuous Events...
Delete Identical Events
Reverse Notes

When one of the above is called from the Track Window only the selected pattern(s) will be 
treated. If you have not selected any patterns, all patterns on the selected track will be 
treated.



Ordering Information
For more information on any of our products, visit our web site, or e-mail us here at 
Evolution: sales@evolution.co.uk 

You can order any of our products directly via the Internet. Simply send details of the 
product(s) that you wish to purchase and we will email you with details of the total cost 
including carriage. 

We accept all major credit cards and can deliver worldwide. 

Either E-mail your order to us at sales@evolution.co.uk or    if you would prefer to order in the
traditional way, see our Address and Telephone details.

Name:
Company: (if applicable)
Email Address:

Telephone:
Fax:
Payment by: Visa Mastercard Access Cheque 

Product(s) :
Quantity:

Evolution Electronics
8 Church Square,
Leighton Buzzard,
Bedfordshire,
LU7 7AE.
United Kingdom

Tel: +44 (0)1525) 372621
Fax: +44 (0)1525) 383228
email: sales@evolution.co.uk

International:
Tel: +44 (0) 1525 372621
Fax: +44 (0) 1525 383228
email: sales@evolution.co.uk

Go to Products Page



Paste
Moves the data from the Clipboard to the song. The new items become the selected ones, 
which makes it easy to move them elsewhere if required.

See also:
Copy, Cut.



Patch Lists...
Evolution's Patch List system allows each MIDI instrument connected to your system to have
its own Patch List to describe the patches available in that instrument.

There are two ways to call up the Patch Lists Dialog.
1. Click in the Patch column in the Track Window. It is the track whose Patch entry is clicked 
on which will be changed.
2. Click on MIDI Menu and choose the Patch Lists... entry. In this case it is the selected 
track's setting which will be changed.

A Patch List file contains:
1. The name of the Instrument (up to 18 characters)
2. A prefix (up to 7 characters)
3. 128 patch names (each up to 18 characters)

The prefix is important because if the track's Patch column simply showed 'Organ', it would 
be impossible to tell which instrument's organ sound was being used, so if an MT-32 was 
receiving on that track's MIDI channel, 'MT32 Organ' would be displayed, as opposed to 'GM 
Organ' or 'U220 Organ'.

The Patch Lists Dialog contains the following:

Current Instrument This combo box contains the names of all patch lists in memory. You 
can choose which instrument's patch list is displayed. Up to 16 patch lists can be held in 
memory.

Instrument Name This edit control allows you to type in a new name for an instrument.

Prefix This edit control allows a new prefix to be entered.

Copy Click this button if you wish to make a copy of the current patch list. You will then be 
able to save it with a new filename.

Add This button lets you load a new patch list from disk.

New Pressing this button starts a new patch list and lets you save it.

Remove This button removes the current patch list from memory. It can be reinstated later 
by pressing the Add button.

Update Files Press this button to save the patch lists, thereby storing any changes 
permanently.

Patch Name This edit control allows you to type a new name for the currently selected 
patch.

Number This shows the number of the currently selected patch. You can type a new number
here as one way of changing patch.

List of Patches This shows the names of all patches in the list. It shows 64 at a time and 
has a horizontal scroll bar which allows you to choose which 64 are visible. Clicking on a 
patch name selects it, copies its name to the Patch Name field and puts its number in the 
Number field. Double-clicking on a name selects it and exits the Dialog as though OK had 



been pressed.

Bank This value is the one shown in the Bank column of the Track Window. It is given here 
so you can change it at the same time you change patch.

Bank Type There are different types of bank message. This switch allows you to decide 
which type of message is sent. GM has no bank messages, so the Bank value is disabled if 
you choose GM.

GS Variations These buttons give you easy access to the bank numbers of the most 
important GS variations. They are only available when Bank Type is GS.

XG Variations This button gives you easy access to the bank numbers of the  XG 
variations. 

Set to OFF Click on this button to exit the Dialog and change the Prog setting to OFF.

Routings... Displays the Routings Dialog (see below).

OK This button exits the Dialog and installs the selected patch in the track's Patch column 
and its number in the Prog column.

Cancel This button exits the Dialog without changing patch.

As is usual in Windows Dialog boxes, the Return / Enter key activates the default button. 
Initially this is the OK button, so pressing return closes the Dialog and installs the selected 
patch in the track's Patch column and its number in the Prog column. The Tab key exits the 
current field. This is the key to use if you have typed a new entry and want to keep it but not
exit the Dialog.

Routings Dialog

This provides an easy way of telling the program which instruments are connected to each 
Output Port. Often one Port can be sending MIDI to more than one instrument, so you can 
enter which instrument is in use on each channel. These connections are used by the Patch 
List system to decide which List to display when the Patch Lists Dialog is called up. For 
example, if Track 4 uses Port B, MIDI Channel 7, the system needs to know which instrument 
is connected to Port B and is receiving on Channel 7. The same knowledge is used when the 
text in the Track Window's Patch column is printed. These routings are changed when a new 
instrument is chosen from the Current Instrument combo box in the Patch Lists Dialog. For 
example, if you click on Track 4's Patch column to call up the Patch Lists Dialog and change 
the current instrument, this change is stored by the system and will also show up in the 
Routings Dialog. You do not have to use the Routings Dialog to set the Port-Channel-Patch 
List connections, but it is an easier way of looking at the information, and in ensuring that in 
future the correct Patch Lists are displayed whenever the Patch Lists Dialog is called up.

The Dialog contains the following:

Port A combo box containing all the MIDI Output Ports in use. Use this to choose which 
Port's connections are displayed.

Channel Instrument Combo boxes Allow each MIDI Channel in the current Port to be 
'connected' to any of the Patch Lists.

Drum Switches Allow you to decide whether each MIDI Channel in the current Port is a drum



channel. Patterns on a drum track can be edited in the Drum Window. Notes on drum tracks 
are not fed in to the Chord readout in the Transport Window. Not all sound cards will support 
playback of drums on MIDI channels other than 10.

Set All Channels to Button and Combo Box provide a quick way of 'connecting' all MIDI 
Channels on a Port to the same Patch List.

The Port-Channel-Patch List connections and the knowledge of which Patch Lists are in use is
stored in .DEF files, so when DEFAULT.DEF is saved on Quit, everything is remembered ready 
for the next session. When you first use Evolution, there will be no DEFAULT.DEF file present: 
this will cause the program to load in 16 Patch Lists by default.

In the Track Window, when you change a track's Channel or Port setting the program also 
updates the Patch column to make sure the correct Patch List is used to show the patch 
name.

The Track Settings and Pattern Settings Dialogs each contain a Patch button. It contains the 
patch name which corresponds to the Program / Port / Channel settings. Pressing it calls up 
the Patch Lists Dialog. Changing the Program, Channel or Port values also updates the patch 
name.

See also:
Track Window.



Piano Roll Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

Vertical Zoom In - display fewer notes in the same space.

Vertical Zoom Out - display more notes in the same space.

To get to the furthest extent of a zoom, hold down the Control key while clicking on a zoom 
button.

Toggle Switches

Speaker Switch - enable sending of selected notes to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected note.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Selectors

Determines the resolution of the Note Display. This value is also used as the note length in 
Step Time entry.

Determines which events are shown in the Velocity Display.

Displays

1. The Timeline shows the bars and beats currently being displayed. The number of beats 
per bar depends on the Time Signature - this can change if there are Time Signature 
changes defined in the Conductor Window. By clicking on the timeline while holding down 
the CONTROL key, the Play Position will jump to the mouse position.



2. The Information Line shows detailed information about a selected note. You can adjust 
these values with the mouse.

3. The Note Display is a grid where notes are shown as rectangles. The horizontal position 
indicates start time. The width of the rectangle shows the note length.

4. The Velocity Display can contain note velocities, after touch, controllers, channel 
pressure and pitch bend. You can edit them with the mouse. Each type of event is shown in a
different colour: the colours are the same as those used in the Event Window.

5. The Screen Keyboard, at the left edge of the window, has four uses:
a) It indicates the pitch of notes in the Note Display.
b) By clicking on it you can play MIDI notes.
c) You can use it to enter notes in step time.
d) It shows notes arriving at MIDI In.

Selecting Notes

You can select notes with either of these two methods:
1. Click on a note - it turns black to indicate selection. Click on another one and that 

becomes the selected note. If you hold SHIFT and click on a note you can toggle its status 
between selected and normal. By using SHIFT clicking you can select several notes.

2. With the left mouse button click on a part of the Note Display where there isn't a 
note. Any selected notes become deselected. While still holding down the left mouse button,
drag down and to the right, enclosing notes in the dotted 'drag rectangle' as you go. Release
the mouse button. The notes inside the drag rectangle become selected. This method is 
called lassoing.

When one note is selected detailed information about it is given in the Information Line. You 
can use the Up and Down arrow keys to move selection to adjacent notes.

Selecting Events in the Velocity Display

Either of the above methods can be used, and the events turn black. If note velocity is being
displayed you can select notes by selecting their velocities.

Using the Edit, Options & Procedures functions

When using functions from the Edit and Options menus, whether events are affected 
depends on their selection states. If you have selected one or more events, ONLY those 
events will be affected. If no events are selected, ALL events will be affected. Remember 
though, that in the Options Menu functions the Scope setting may exclude some of them.
One method of copying one or more events is to select them and use the Copy function (Edit
Menu) to place a copy of them on the clipboard. You can then Paste them into the pattern at 
the current Play Position.



Moving and Copying Events

Selected events can be moved and copied. Click on any one of them and drag to a new 
position then let go of the mouse button. If you hold down the CONTROL key before you 
click, a copy of the events will be made at the new position, leaving the originals intact. The 
newly copied events then become the selected ones.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool 
Selector. Move the mouse until the one you want is highlighted. Let go of the right mouse 
button - the selector disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button 
and release immediately - there's no need to drag.

2. The Pencil is used for drawing and sizing. In the Note Display you can draw in a new note
or change the size of an existing note. To move the start position of a note click on the left 
half; to move the end of a note click on the right half. Drag the mouse to the required 
position and release the mouse button.

You can also draw in the Velocity Display. If any event type except Velocity is chosen as the 
display type, you can use the pencil to draw in new data, a pitch bend curve, for example.

3. The Eraser is used to delete events. It works in both the Note and Velocity Displays. Click 
on an event with the eraser and it disappears. If you click on one of a group of selected 
events, all the selected events are deleted.

4. The Cross hairs cursor is used for modifying existing data in the Velocity Display. Hold 
down the left button and drag the mouse around - if the cross hairs move across any data it 
will change to a new value proportional to the height of the cross hairs in the display. You 
can use a single click to change a single value or drag the mouse right and left to reshape a 
controller curve. If Velocity is the display type you can create a crescendo by dragging the 
cross hairs left to right across the velocities, moving up the screen as you go.

5. The Knife is used to slice a note in two. The position you click on the note determines the
end position of the first note and the start of the second one.

6. The Glue is used to join two notes of the same pitch to create one new note which starts 
where the first note started and ends where the second one ended. Click anywhere on a 
note and it will be glued to the next note of the same pitch.

Step Time Entry

The Step Switch must be in the ON position. Single notes and chords arriving at MIDI In are 
recorded at the current Play Position with a length determined by the Grid setting. When you



release the notes on the MIDI keyboard the Play Position advances by the same amount. To 
advance the Play Position without entering a note, press the space bar.

You can also use the Screen Keyboard to enter notes -- click on one of the notes and a note 
of that pitch is recorded. The Play Position doesn't advance automatically, but stays in the 
same place to make it easy to enter successive notes of a chord. Press the space bar to 
advance the Play Position.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

See also:
General Window Information, Event Window, Conductor Window.



Preferences...
The Copy Patterns as Parents switch determines the type of pattern created when a 
pattern is copied. If this switch is turned off, copying a pattern results in a Child Pattern 
being created, which is denoted by a dotted border. A Parent Pattern has a solid border.

The Chord Track Conflict warning switch determines whether a message is displayed 
when one or more MIDI Tracks is set to the same Port and Channel as the Chord Track. If the 
switch is turned on, this message is displayed each time you start playback or recording.

The Conductor warning (Audio Timing) switch determines whether a message is 
displayed when you change or insert a tempo point in the Conductor Window, in such a way 
as to affect the timing relationship between MIDI and audio data. Audio patterns play back at
the same speed they were recorded at, whereas MIDI data plays back at a speed dictated by
the current tempo setting.

The Ask before extract type 0 MIDI file switch determines whether you are asked about 
extracting single track MIDI files to multiple tracks when you load them. If this switch is off, 
no message is displayed, and the single track is automatically extracted. If it is turned on, 
you are given a choice each time you load a type 0 MIDI file.

The Single Edit Window switch allows only one edit window (Piano Roll, Event, Score and 
Drum) to be open at any one time. If, for example, you have a Piano Roll window and open 
the Event window, the Piano Roll closes first. Also, when you have an edit window open, 
clicking on a different pattern brings that pattern into the edit window (this isn't possible 
with multiple editing windows as you need to click on a pattern before opening a new edit 
window). Turn this switch on if you think it suits your way of working.

The Timer Resolution slider allow you to tell the Windows Multimedia Timer how to supply 
timing pulses to he program. It determines how many milliseconds will elapse between each 
timer pulse. The finest resolution is 1 ms.

On slower computers lower values will make the Windows Multimedia Timer use a lot of the 
PC's computing power, leaving little available for doing other things. Users with slower 
computers who experience unsteady playback will find it helpful to increase the Timer 
Resolution until playback is steady. The three buttons - 386, 486, and Pentium - provide 
useful settings for you to begin with.

See also:
Track Window.



Your printer is not recognized by the program. If it prints from other programs, then it is probably a colour 
printer and to be able to print from EVAP you need to install a monochrome driver for it. Please check 
with your printer manufacturers that you have the latest drivers for the printer as there are known 
problems with some colour printer drivers.
e.g. To use a HP Deskjet 550C printer you might have to install the HP Deskjet 500 driver from your 
Windows installation disks / CD-ROM.

Set the monochrome driver as the default printer when printing from EVAP.



Print Troubleshooting
If you encounter problems when printing from the score editor please click and check the following list for 
any known problems before giving technical support a call.

1. Clicking on page preview displays only a blank page.
2. Program gives a General Protection Fault (GPF) when trying to print.



If you encounter a GPF (General Protection Fault) when trying to print from the score editor, it is probably 
down to the fact that your printer drivers are not compatible with the software. Please check with the 
printer manufacturers that you are using the latest drivers.

If you are using a colour printer, install a monochrome driver for it. e.g. To use a HP Deskjet 550C printer 
you might have to install the HP Deskjet 500 driver from your Windows installation disks / CD-ROM.

Check that the printer works from other applications such as Notepad or write. If not, then go to your 
control panel and reinstall the printer drivers.



Quantize...
Allows you to change the start positions of one or more notes so they are more regularly 
placed. Notes move forward or backward depending on where the nearest beat or division of
a beat is. A Dialog is displayed where you decide the Quantize Setting (16ths etc.), the 
Percentage by which the notes will be moved, and the Scope of the change.

The percentage setting allows notes to be lightly or heavily quantized. With a Quantize 
Setting of 16ths, a percentage of 50 will make notes move half way to the nearest 16th, 
while 100% will make them move all the way.



Quit
Choose this when you want to get out of the program.





Redo
Reverses the effect of Undo.



Reverse Notes
Allows you to change the start positions of a group of notes so they play in reverse order.

When this is called from the Track Window only the notes in the selected pattern(s) will be 
reversed. If you have not selected any patterns, the notes in all patterns on the selected 
track will be reversed.

If you call it from an editing window (e.g. Piano Roll or Event) you can define which notes are
reversed. If you select a number of notes, only those notes which are selected will be 
reversed. If you have not selected any notes, all notes will be reversed.



Save...
This is where you can save a file you are working on. When you enter the File Dialog, the 
name of the file last accessed is shown and the directory shows only files of that type. You 
can change the file type by clicking on one of the radio buttons at the right side of the 
Dialog.

If you are saving a song, you could use the Save Song function, which is quicker.

If you are saving a MIDI file, you can save either a Type 0 file (a single track) or a Type 1 file 
(two or more tracks). The program checks to see how many tracks contain patterns. If only 
one track contains patterns, it saves a Type 0 file, otherwise it saves a Type 1 file.

If you have several tracks containing patterns, but want to save a Type 0 file, choose Select 
All from the Edit Menu, then Merge Patterns from the Track Window's Functions Menu. Delete
the old tracks so only the 'Merged' track remains. Choosing Save... will now save this as a 
Type 0 file.



Save As...
When you want to save a new file for the first time this is the function to use. You need to 
specify which type of file you want to save, then type in the name in the filename entry at 
the top of the Dialog.

You can also use this to save a file you are working on with a different name, thereby 
copying it.

If you are saving an untitled song, you could use the Save Song function.
If you are saving a MIDI file, you can save either a Type 0 file (a single track) or a Type 1 file 
(two or more tracks). The program checks to see how many tracks contain patterns. If only 
one track contains patterns, it saves a Type 0 file, otherwise it saves a Type 1 file.

If you have several tracks containing patterns, but want to save a Type 0 file, choose Select 
All from the Edit Menu, then Merge Patterns from the Track Window's Functions Menu. Delete
the old tracks so only the 'Merged' track remains. Choosing Save As... will now save this as a
Type 0 file.



Save Song
This is a quick way of saving the Song you are working on. The File Dialog is not displayed - 
the filename of the current song is used so you don't need to tell the program again.

If you try to use this to save an untitled song, the File Dialog will be displayed, but only 
the .SNG file type will be allowed.



Scope

The Scope setting allows you to restrict the range of notes which will be treated. For example you may 
want to change only notes From G 2 To C 4. The values are inclusive, so in this example G 2 and C 4 
would be treated as well as all notes between. Alternatively you can choose to treat All notes.

If you call the Options menu function (Transpose etc.) from an editing window (e.g. Piano Roll or Event) 
you can define scope more precisely. If you select one or more notes, only those notes which are 
selected will be treated. This overrides the Scope setting, and the Scope controls in the Dialog are 
disabled. However, if you have not selected any notes, the Scope setting acts just as if you had called it 
from the Track Window.



Score Settings...
Displays a Dialog containing the settings which help determine the layout of the score 
display, both when editing and printing.

Margins (points from the edge of the 
screen / page)

Left, Right, Top, 
Bottom

Spacing (points)
Inter-note the horizontal distance between 

notes / rests.
Inter-stave the vertical distance between 

staves.

Text Sizes (points)
Title size of the font used for the song 

title printed at the top of the page.
Names + Bars size of the font used for the patch 

name and bar number.

Clef can be Treble (normal, 8va above, 
8va below), Bass (normal, 8va 
above, 8va below), Treble and 
Bass.

T & B Split Point the lowest note placed on the 
Treble Stave when using the Treble
and Bass clef.

Detect 
Automatically

this switch turns Automatic Clef 
Detection off if required.

Detect Now this button tells the program to 
detect the clef immediately. The 
Stave Display updates if a different
clef is calculated.

Printing
Print Page 
Numbers

the page number will be printed at
the foot of each printed page if 
this is turned on.

Maximum Staves this lets you limit the number of 
staves printed on each page.

Sloping Beams these switches turn this feature on
or off as required.

Screen, Printer

Display Bar 
Numbers

this switch turns on the numbering
of bars and applies to both screen 
and printer.

Simplify Display this switch makes the display less 
exact but easier to read. It reduces
the number of short rests by 



modifying note durations. This is 
only a visual change, the MIDI 
data is not affected.

Lyrics on Channel type in the MIDI channel 
containing the lyric melody. The 
Score Window needs to know this 
so it can display the lyrics under 
the correct notes.



Score Window
Toggle Switches

Speaker Switch - enable sending of selected notes to MIDI Out.

MIDI Edit Switch - enable MIDI Input to edit selected note.

Step Switch - enable Step Time entry.

Buttons

Close the window.

Restore the pattern's original contents.

Switches the Stave Display between Print Preview and Edit.

Selectors

Determines the shortest note and rest drawn in the Stave Display.

This value determines the shape of the Note cursor and is used in Step Time entry.

Displays

1. The Information Line shows detailed information about a selected note. You can adjust 
these values with the mouse.

To the right is a display of the pitch and position (bars:beats:ticks) of the mouse.

2. The Stave Display is where notes are shown on a stave. The clef can be changed in the 
Score Settings Dialog. If you click on an empty part of the Stave Display while holding down 
the CONTROL key, the Play Position will jump to the mouse position.



Single or Multi channel Staves

If you select a pattern containing notes on one MIDI channel and then open the Score 
Window, a single part display is created. If you open the window with a pattern containing 
notes on two or more MIDI channels, a multiple stave system display is generated, with each
instrument having its own stave.

Selecting Notes

You can select notes with either of these two methods:
1. Click on a note - it turns red to indicate selection. Click on another one and that 

becomes the selected note. If you hold SHIFT and click on a note you can toggle its status 
between selected and normal. By using SHIFT clicking you can select several notes.

2. With the left mouse button click on a part of the Stave Display where there isn't a 
note. Any selected notes become deselected. While still holding down the left mouse button,
drag down and to the right, enclosing notes in the dotted 'drag rectangle' as you go. Release
the mouse button. The notes inside the drag rectangle become selected. This method is 
called lassoing. To continue lassoing. notes in later bars, hold the mouse against the right 
edge of the window and the display will flow more notes into the lasso rectangle.

When one note is selected detailed information about it is given in the Information Line. You 
can use the Up and Down arrow keys to move selection to adjacent notes.

Using the Edit, Options & Procedures functions

When using functions from the Edit and Options menus, whether events are affected 
depends on their selection states. If you have selected one or more events, ONLY those 
events will be affected. If no events are selected, ALL events will be affected. Remember 
though, that in the Options Menu functions the Scope setting may exclude some of them.
One method of copying one or more events is to select them and use the Copy function (Edit
Menu) to place a copy of them on the clipboard. You can then Paste them into the pattern at 
the current Play Position.

Moving and Copying Notes

Selected notes can be moved and copied. Click on any one of them and drag to a new 
position then let go of the mouse button. If you hold down the CONTROL key before you 
click, a copy of the notes will be made at the new position, leaving the originals intact. The 
newly copied notes then become the selected ones.

Functions Menu

Print... Displays a standard Windows Print Dialog.
Print Setup... Displays a standard Windows Print Setup Dialog.
Delete Lyrics... Deletes all the lyrics in the song.

Mouse Tools



To select a different mouse, hold down the right mouse button to bring up the Mouse Tool 
Selector. Move the mouse until the one you want is highlighted. Let go of the right mouse 
button - the selector disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button 
and release immediately - there's no need to drag.

2. The Note cursor enters a note with a length specified by the Note Len combo box. The 
pitch and position are calculated from where the mouse button clicks on the stave. These 
values are shown in the Information Line. The Note cursor can also be used to change the 
length of an existing note - the note's length changes to that of the cursor.

3. The Eraser is used to delete notes. Click on a note with the eraser and it disappears. If 
you click on one of a group of selected notes, all the selected notes are deleted. The eraser 
can also be used to delete lyrics - just click on the lyric.

4. The Glue is used to join two notes of the same pitch to create one new note which starts 
where the first note started and ends where the second one ended. Click on a note and it will
be glued to the next note of the same pitch. This can also be thought of as a means to tie 
two notes.

5, 6. The Sharp and Flat cursors are used for modifying existing notes. One sharpens a 
note, the other flattens it. If the SHIFT key is held down the note changes by an octave, 
otherwise it changes by a semitone.

7. The Pen is used to enter and edit lyrics. Click on an existing lyric and an edit control 
appears, into which text can be typed. TAB moves to the next lyric, RETURN terminates 
editing.

If you want to add lyrics, click on the head of the note under which the lyric is needed; a new
lyric is created. When you have finished editing this lyric, press TAB to advance to the next 
note without a lyric and type again. When you have finished, press RETURN to stop editing.

When you make a change to the lyrics, they will immediately be reflected in the Lyric 
Window if it is open. You can cause a line feed by typing a lyric event containing a # sign 
only. This allows you determine the line breaks for when the lyrics are printed in the Lyric 
Window.

Step Time Entry

The Step Switch must be in the ON position. Single notes and chords arriving at MIDI In are 
recorded at the current Play Position with a length determined by the Note Len setting. 
When you release the notes on the MIDI keyboard the Play Position advances by the same 
amount. To advance the Play Position without entering a note, press the space bar.

Time and Key Signatures

Different time signatures can be displayed, allowing any changes in the Conductor Window 
to be acted upon when the score is displayed.

Automatic Clef Detection

On entry to the Score Window the program scans the pitches and works out the best clef to 
display the notes on. It is not called at any other time, so it is still possible to change the clef



in the Score Settings Dialog without the program changing it back. You can turn Automatic 
Clef Detection off.

Using the PC Keyboard

The keys 1 to 7 on the top row of the PC keyboard can be used to change the value in the 
Note Len combo box. The 'D', 'N' and 'T' keys select the dotted, normal or triplet version. If 
the Note cursor is in use, its shape changes.

Printing

The Print function can print anything which can be displayed on the screen. All settings in 
the Score Settings Dialog apply to printer output. Printing also obeys the settings in the Print
Dialog - which pages to print, how many copies and whether copies are collated.

Printing can be aborted while the page is being sent to the printer. Press the Abort button to 
abort printing.
Print Troubleshooting

Print Preview

The Print Preview / Edit switch toggles between Print Preview and the normal Edit display. 
The Print Preview display is a scaled version of what will appear on the printed page. The 
scale depends on the window size - on an 800x600 display a better display is possible than 
on a 640x480 display thanks to the extra display area available.

The Page number is printed and two arrow buttons are displayed to allow the page to be 
changed - the PgUp and PgDn keys operate these buttons as well as the mouse.

Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

See also:
General Window Information, Conductor Window.



Select All
Selects all items in the current window. Selected items are black (except muted patterns 
which change from light grey to dark grey).



Software Package
Sound Studio Pro Plus(Evolution Audio and Samplitude MM)

CD Quality sound is no longer confined to professional studios. Sound Studio Pro Plus combines 
Evolution Audio and Samplitude Multimedia giving 256 MIDI and 4 audio tracks running in sync. Sound 
Studio Pro Plus will transform your PC into a recording studio. You can make multitrack recordings on to 
your hard disk, manipulate them in a user friendly graphical format and integrate them with video clips 
in .AVI format.

Return to Products Page



Synchronization Settings...
If you need to make Evolution play in time with an external device, the settings in this Dialog
can be configured accordingly.

If you're using Evolution as the master clock, you'll need to Send either MIDI Clock or MIDI
Time Code. If Evolution is to be slaved to an external clock source, you'll need to Receive 
timing information.

The Synchronization Settings Dialog contains separate controls for receiving and sending 
timing data. You simply click on the type of sync you need to use and choose the Port to 
which you've connected your MIDI cable. If you use MIDI Clock there's no need to change 
any of the frame rate settings or the Song Start time. These are only relevant when MIDI 
Time Code is being used.

If you're using MIDI Time Code, you must make sure Frames per Second is set to the same
as the external device. The Song Start Time defines what time is considered to be the start 
of the song.

Relocate Delay is relevant to both MIDI Clock and MIDI Time Code, but only when Evolution
is Sending. When you move the Play Position, Evolution tells the external device to get ready
to start at that position. Relocate Delay gives the receiving device time to get ready. 
Different devices need different delays, so you'll need to experiment until the two machines 
are working smoothly together - a setting of 500ms is a good starting point. If you're not 
sending sync to an external device, set this value to zero.



Evolution Electronics offers free technical support for registered EVAP users.
email:    support@evolution.co.uk

If you have a problem, before contacting Technical Support, please read the relevant section of the manual. If 
telephoning for support please have the phone close to the PC which is running the software. Please remember that 
the lines are usually very busy, so E-mail would be the better option.

When asking for technical assistance, please have the following information to hand:

 VERSION NUMBER e.g. 1.01... (To be found in "About Evolution Audio Pro" from Help menu.
 OPERATING SYSTEM:    e.g Win 3.11                      
 HARDWARE PLATFORM: e.g. IBM PC
 CPU: e.g.      486                                                
 CPU speed: e.g. 33 MHz                                      
 RAM:      e.g. 8Mb                                            
 SOUND CARD:

Evolution Electronics
8 Church Square,
Leighton Buzzard,
Bedfordshire,
UK
LU7 7AE.

UK:
Tel: 01525 372621
Fax: 01525 383228
email:    support@evolution.co.uk

International:
Tel: +44 1525 372621
Fax: +44 1525 383228



The Arranging Tutorial
What we are going to do is show how powerful the pattern-based approach to sequencing is,
and how easily a song can be constructed using some of the features in EVAP. This will give 
you a good understanding of how EVAP works so you can use the same principles and 
techniques in your own music.

Parent and Child Patterns
Adding Audio Files
The Toolbox
Moving and Erasing patterns
Loading Audio files
Saving your work
Mixing
Adding Reverb and Chorus
Recording the Mixer settings
Staggering the Mixer data
Quiet in the mix
Mixing the audio track

Open the file called TECHDEMO.SNG. This contains several patterns spread across the tracks
rather than the one-pattern-per-track arrangement of Sheba. We will use these patterns as 
our building blocks.

It's normal practice to have the Name column on view. It will help if you can also see the 
Patch, Transpose and Ch columns. Check them in the Select Track Columns dialogue box as 
described earlier.

The patterns are configured for General MIDI. If you are using a non-GM instrument, select 
sounds similar to those listed in the Patch column.

You might want to play the song as it is. You can tell it's a Coda short of a full Sonata but 
we'll soon fill in the missing pieces. Adjust the Zoom controls so you can see all the patterns 
in the Pattern Display area. You may want to zoom in and out as you 

We're going to construct a piece of Techno music which is based on repeating riffs and we'll 
begin by constructing the bass line. Listen to the Bass pattern in the first couple of bars. It's 
a bit bland. Hold down the Control key and click and drag the pattern onto the same position
in Track 2.

You'll see the new pattern has a dotted outline. If it doesn't you've probably changed the 
Preferences so open Preferences... in the Options menu and uncheck the Copy Patterns 
as Parents box.

Parent and Child Patterns

By unchecking the box you tell the program you want to copy patterns as Children rather 
than as Parents. The difference is important and illustrates just one of the many flexible 
features of pattern-based recording. If you copy a pattern as a Parent then you simply create
a completely new individual pattern the same as the original. The result is similar to copying 
and pasting a section of text in a word processor.

However, if you copy a pattern as a Child, it has no events of its own but uses those of its 
Parent. If you change the events in a Parent pattern then all the Children patterns 
automatically use the new events too. This is perfect for riff-based sequences because if you



decide to change one of the riffs, all the others change as well. It saves an awful lot of work!

However, you can play the Children patterns back on any MIDI channel and apply processes 
such as Transpose to them which gives them a bit of independence of their own. Let's do this
with the bass line.

Assuming you've copied a Child Bass pattern to Track 2 and set the Snap value to 8. The 
Snap setting helps you line up patterns when you move them as they will automatically 
"snap" to the bar division set in the Snap box. Zoom in so you can see the first two bars 
clearly and then click and drag the Child pattern to the first 1/8th division of bar 1.

As this is on its own track you can assign it to any MIDI channel and give it any Program 
Change number you like. However, let's stick with the Syn Bass sound and either assign 
Track 2 to MIDI channel 1 or else leave Track 2 on MIDI channel 2 and select the Syn Bass 
sound. The first option conserves MIDI channels but the second gives you more flexibility, 
should you need it.

Now when you play the first couple of bars, each of the notes in the bass line will repeat 
creating a 1/8th note bass line.

Click in the Transpose column and take the Child pattern down by -12, an octave. Sounds a 
bit more interesting, doesn't it? Notice that the Child pattern is still playing the same notes 
as the Parent but we have simply transposed them.

The next step is to copy these two patterns to provide a longer bass line. Click and drag a 
box around the two Bass patterns. This is known as lassoing and to select a pattern in EVAP
this way you have to capture the start of the pattern in the lasso. You don't have to drag a 
box completely around the pattern to take in the end of it. When a pattern has been 
captured or highlighted in this way it turns black.

We want to create seven copies of this dual Bass pattern. You can set the Snap value back to
Bar for this. Put the mouse on a part of the highlighted patterns, hold down the Control key 
and click and drag the patterns to the right until the start of the top one is on Bar 3. Release 
the mouse button. You don't have to be terribly precise as the Snap function will place the 
patterns on the nearest bar.

Now, the patterns you have just placed will be highlighted so continue to hold down the 
Control key, click and drag the patterns onto bar 5 and release the mouse. Continue until 
you have made seven copies of the patterns. The last one will begin on bar 15.

The Pattern Display window will scroll automatically as you copy the patterns past the right 
hand edge so there's no need to release the mouse button to click on the scroll bar.

Play the song.

Just to illustrate the purpose and usefulness of the Parent/Child pattern relationship, 
highlight the first pattern, the original Parent, and click on the Event editor. We'll look at this 
more closely later but for now pick out the second F#2 in the list and click on it with the left 
mouse button three times. It will be transposed downwards to Eb2. Now when you play the 
piece that note will be played by all the Child patterns.

Put it back to F#2.

Next, we'll fill out the drum part. As you did before, while holding down the Control key click 



and drag the Hit Hats pattern to the right until the start is on Bar 5. Repeat this to create six 
copies in all, the last one starting at bar 15.

The Tambourine comes in at bar 5. Copy this six times so the last pattern starts at bar 17.

Now copy the Vibes pattern five times.

Adding Audio Files

That's the first part done. The Strings and the Hit parts are in place and don't require any 
further editing. But what happens after the hit? Not a lot. Let's liven it up by adding some 
vocals.

The ability to add digital audio to MIDI tracks is one of EVAP's major features. With 
Samplitude Lite you can record your own digital audio but for now let's insert a few audio 
snippets we prepared earlier.

First we need to create an audio track. Click on the Function menu in the Track editor and 
select Add Audio Track. A track labeled AUDIO - surprise, surprise - appears at the top of the 
track list.

We will now insert a voice saying the letters of the word "TECHNO" into the audio track. 
There is more than one way of doing this but we'll plumb for the easy way. Zoom in until you
can see each bar number in the Timeline. Set Snap to 4.

The Toolbox

Right-click and hold in the Pattern Display area and the Toolbox appears.

Each editor has a Toolbox and some tools appear in more than one editor. There is a 
complete list of all the Tools in the Basic Operations chapter. At the moment we're just 
interested in the Pencil so move the pointer to it and release the Mouse button.

Scroll the window so you can see bar 11 and click the Pencil in the Audio track halfway 
between the numbers 11 and 12. an Audio pattern will appear 1/4 of a bar long.

These are markers or place-holders for the audio data and they tell the program when to 
play the audio in relation to the rest of the song. The audio is not held in the computer's 
memory but read directly from disk so you don't need a lot of RAM in order to use audio files.

Moving and Erasing patterns

If you accidentally create a pattern where you don't want one you can click and drag it to 
the correct location or erase it. Right-click in the display area, select the Eraser and release 
the mouse button. Now click with the Eraser on the unwanted pattern and it will be deleted.

Another way to remove unwanted patterns is to highlight them and press the Delete key on 
the computer's keyboard.

If you delete a pattern accidentally, select Undo from the Edit menu or hold down the Alt 
key and press the Backspace key.

Now we have to tell the program which audio files we want it to play.



Loading Audio files

Right-click briefly in the Pattern Display area and the mouse pointer will run into an Arrow 
again. Double-click on the first Audio pattern and the Audio Pattern Settings window 
opens.

Click on the Wave File button near the top of the window and a file dialogue box opens 
looking for a file with a .WAV extension. These are standard Windows audio files and you will 
see several in the EVAP directory including ones called T, E, C, H, N and O.

Double-click on T.WAV or click on it to highlight it and then click on the OK button. A 
representation of the waveform appears in the window.

Click on the Audition button and you you'll hear the audio file play along with the MIDI 
patterns which are at the same place in the song. The name of the file will still be called 
AUDIO so highlight it and change it to T.

This window also shows the size and format of the file. We're using 8-bit mono files recorded 
at 22.05kHz, partly to save your disk space and partly so users with older sound cards can 
play them. If your sound card supports 16-bit stereo 44.1kHz files and you use files of this 
standard you will get a far superior sound quality.

Click the OK button and a box will appear asking if you want to Resize the Pattern to 
match the Wave Length. At the moment, each Audio pattern is exactly quarter of a bar 
long but if you click on OK here, the length of the pattern will be adjusted proportionally so 
you can see where the audio file will stop playing. Click OK.

Now open the other audio patterns, load the E, C, H, N and O WAV files and change their 
names accordingly.

Each file lasts for about a quarter of a bar but you will see that some patterns are slightly 
longer than others. If you are working with very short samples or zoom out of the display to 
get an overall view of the arrangement, the audio patterns may become little more than a 
line wide. By not Resizing the Pattern to match the Wave Length you keep the patterns at 
their original size which will make them easier to see and manipulate.

Now let's finish fill in the gap which leads to the Piano and Drum parts. We need half a 
Tambourine pattern so right-click in the Pattern Display area and select the Knife tool.

Zoom in so you can see the last Tambourine pattern clearly, set Snap to Bar and click the 
Knife in the middle of the pattern under bar 18 in the Timeline. With Snap set to Bar you 
don't have to be very accurate and the pattern will split in two.

You'll notice that it has also taken on a solid outline. In other words, it has ceased to be a 
Child pattern and has become a Parent pattern. This has happened because you edited it. As
the two patterns no longer contain the event of the Parent pattern they have become 
Parents in their own right.

Right-click briefly to select the Arrow again. Hold down Control and click and drag the right-
most pattern a bar along so it fills bar 19. Now Control click and drag the previous Child 
pattern, the one occupying bars 15 and 16, to bar 20. Create three more copies, extending 
the Tambourine line to the end of bar 28.



Let's have some more voice. Lasso the five Audio files and Control click and drag them to 
the right so the first audio part, the T, is at the start of bar 18. Click anywhere in the Display 
area to deselect the parts and set the Snap value to 4.

Drag the E to the middle of bar 18. We want the next four files to each occupy a beat in bar 
19 so zoom right in and drag the files onto consecutive beats.

Now Control drag the Drums pattern three times and the Piano pattern. They should both 
come to the end of bar 28 in line with the Tambourine pattern. Now Control drag one copy of
the SynBass pattern.

Saving your work

Before you continue, save the song. Select Save As... in the File menu and the file dialogue 
box appears.

You want to save entire piece so make sure the .SNG box is selected, type a name into the 
Filename box and press Return or click on OK. You don't have to add the .SNG extension, 
EVAP will do that for you automatically.

If you want to compare it with the arrangement we prepared earlier, load the TECHNO.SNG 
file.

Mixing

The final step is to mix the piece. The original patterns were recorded to sound pretty well 
"mixed" on our GM unit but they may not sound exactly the same on yours. In any event, 
there are still a few tweaks to perform.

Open the Mixer by clicking on its icon.

The MIDI Outputs available in your system will appear long the top of the window. These are 
the same as the Port settings in the Track window. Select the one you are using by clicking 
on it and then click on the Auto Size button.

This will automatically resize the window so it is the exact height and width of one set of 16 
channels. If you have a small monitor or are running EVAP in a low resolution you may want 
to make the mixer smaller to hide the higher-numbered channels which you aren't using. You
can do this by clicking and dragging on the borders of the window in the usual way.

To set the Mixer controls to a default setting, click on the All Flat button. This will set 
Reverb and Chorus to off, Pan to centre and Volume to maximum.

Select Mixer Settings... from the Options menu. This lets you determine how the Mixer 
works and what the mixer controls actually control.

The two boxes labeled User 1 and User 2 let you configure the top two rotary dials in the 
Mixer to control a range of Controllers. There's more about this in the Reference section but 
leave them set to Chorus Depth and Reverb Depth for now.

Select one of the items under Text Under Faders to decide what information you want to 
see under each Mixer channel. We prefer Patch Names so you can see what sound the Mixer 
is controlling but if you name your tracks you might prefer to set it to Track Names.



The following boxes let you decide how MIDI data and the Mixer interact. If you are only 
using one MIDI Out Port, we'd suggest keeping the first three boxes checked even though 
you don't need all the facilities at the moment. There's more about these settings in the 
Reference section.

Now play the song.

First of all, use the faders to set suitable volume levels for each of the tracks. Maximum 
volumes for all sound fine on our equipment but even General MIDI modules vary from one 
to the other.

Now, experiment with the Pan settings. Pan the first Bass track hard right and the "echo" 
hard left. Put the Vibes slightly right of centre and the strings slightly left of centre.

We usually leave the drums in the middle but you might like to pan the Piano slightly left and
the Syn Saw slightly right. These are just suggestions, of course. Place the sounds wherever 
you like in the stereo image.

Adding Reverb and Chorus

Next, add some Reverb. This can really fill out a sound. Strictly speaking, Reverb is not a 
feature of General MIDI although many GM units have a Reverb feature. You'll soon be able 
to tell if yours is one by turning up the reverb level and seeing if the sound takes on a 
"spacey" quality.

Try adding reverb to the original bass line or to the "echo". If you have the two bass parts on
different MIDI channels you can put reverb on one and not the other.

See how it affects the other parts including the drums. Many beginners add reverb to 
everything and although this appears to "beef up" a song it can result in the "swamp" effect 
and make the parts blur into one another. Still, if that's the effect you're after...

You may like to add a little Chorus to some of the parts. If your sound source supports it, it 
will thicken a sound.

Use the Mute and Solo buttons in the Mixer to hear what the parts sound like in isolation.

Recording the Mixer settings

Now, having fine tuned the song, you want it to sound like this every time it's played so we 
need to record the settings into the song itself. This is easy to do using the Mixer's 
Snapshot button.

Make sure the Record mixer movements box is checked in the Mixer Settings dialogue 
box. From the Functions menu in the Track editor select Add MIDI Track or simply click on 
the Add MIDI Track button.

A new track will appear at the bottom of the track list. Click on the button in the Rec 
column. If this column is not on screen, check it in the Select Track Columns box. Now, 
during recording, when you click on the Snapshot button the data will be recorded onto the 
track.



However, you'll notice that the song begins at the start of the very first bar so there's no 
room to insert this information. Click on Select All in the Edit menu and all the patterns will 
highlight. Zoom in and use the scroll bars so you can see the bar markings in the Timeline 
clearly. Set Snap to Bar. Click on the first Bass pattern in the song and drag it to bar 2. The 
whole song will move along a bar.

Now click somewhere on the Mixer window or on the Mixer icon to bring it to the front. Click 
on the Record button in the Transport window and, unless you've altered the Metronome 
settings, a one-bar count in window will appear counting down from four to one. If the 
Metronome icon is selected in the Transport window, you'll also hear a click.

As soon as the program starts recording, click on the Snapshot button and then on Stop. 
Let's just check what you've recorded.

Select the pattern in the Track window and click on the Event Editor icon. Make sure the 
Controller button in the Display Filter is on and you will see a list of Controller data similar 
to this:

Scroll through the list and you will see that each MIDI channel has an entry for Volume, Pan, 
Reverb and Chorus. If you've checked the Song data to mixer box in the Mixer Settings 
window, the Mixer controls will move in response to the data during playback. Try it. Flatten 
the Mixer controls and then start playback.

Not working? Check the MIDI channel the track is set to. It's probably set to channel 11 
which means all the data is going to MIDI channel 11 and none to the other channels. Scroll 
this down to 0 with the left mouse button. Now the data will be transmitted on the MIDI 
channels which are used in the pattern rather than being forced onto a MIDI channel by the 
Ch setting.

Staggering the Mixer data

A couple more points before we move on. If you hit the Snapshot button after the count in, 
the events will be spread a few ticks apart. If you clicked on Snapshot before the count in 
had finished, the events will still have been recorded but they will all be on the very first bar 
and beat position.

MIDI is a serial protocol which means it can only transmit one item of data at a time. If 
events are at the same time position it sends them one after the other, albeit very quickly. 
However, if there are a lot of events, the last one could arrive significantly later than the first
one, even though they have the same time position in the editor.

Now, most instruments respond to MIDI data very quickly but they do take a finite time to 
react to it and some may be swamped if they receive too much data at once. It may ignore 
some data or it may cause a glitch in the system. The Snapshot button staggers the events 
to minimize problems such as this.

Depending on your instrument, you may be able to stack all the set-up events on the first 
beat but it's usually best to play safe and spread them out a little, particularly if you are also
using System Exclusive data to put an instrument into GM, GS or XG mode. There's more 
about this in the Appendix.

It's now common practice to use the first bar for set up data and to begin the song proper at 
bar 2.



Quiet in the mix

Finally, you will have noticed that the Snapshot button records data for all MIDI channels, 
regardless of whether or not the song uses them. The extra data won't do any harm and 
hardly takes up any space in the file but you can turn this to your advantage.

Some instruments emit a little bit of background noise. This is usually caused by the sound 
generation circuitry. So, as well as adjusting the volume levels for the MIDI channels you are 
using, set the ones you aren't using to 0 to reduce any background noise.

Congratulations! You have learned some of the main principles of pattern-based arranging 
and know your way around EVAP's Track window and Mixer.

If you haven't done so already, look at the other files. Most were created using a pattern-
based approach and you can see how Parent and Child patterns have been used to structure
the pieces.

Mixing the audio track

We have mixed the MIDI tracks but what about the audio track? Audio playback is through 
your sound card so you must use your sound card's software to set the balance. Most sound 
cards come with a set of utilities for playing MIDI and WAV files and virtually have a software 
mixer.

Sound Impression is a popular one and bundled with several sound cards:

The Creative range of Sound Blaster cards include the Creative Mixer:

Whichever mixer you have, use the Wave control to set a suitable balance for the audio 
track. You may also be able to pan the audio parts left and right. If you are also using the 
sound card to play the MIDI parts, you will be able to adjust their volume with the mixer, too

That's the end of the Arranging Tutorial.

What do you mean, the Techno song isn't finished? Well, it's served its purpose and if you 
like it, why not finish it yourself? - after completing the rest of the Tutorial, of course!



The Chords Track Tutorial
Arranging the Chords tracks
Realtime Style Playing
Realtime Chord Recording
Using the on-screen keyboard to record chords in realtime
Using your QWERTY keyboard to record chords in realtime.

We'll now look at one of EVAP's most interesting features - the Chords Track. This lets you 
create a full six-part accompaniment very quickly in one of 16 styles.

Select New from the File menu and save whatever you've been working on. Let's create a 
Hooked On Classics piece using Liszt's Liebestraum. We've put the piece, originally in 3/4 
time, into 4/4 and we'll give it a Disco rhythm.

First we'll create the chord track. The chord sequence is as follows:

F A7 D7 G Gm/C F /
F A7 D7 G Gm/C F /
Gm F Dm7 A7/C
F A7 D7 G Gm/C F /

Note that the Gm/C and the A7/C symbols indicate two chords in one bar, each lasting two 
beats.

Set Chord Snap to Bar and Select the Pencil tool. Click in the Chords Track and drag from 
Bar 1 into bar 2. The Snap function will make the pattern fill the two bars. You'll see a new 
set of data appear in the Information bar which we'll get to in a moment.

Click another six patterns into bars 3 to 8. You don't have to click and drag, just click near 
the start of the bar and the pattern will automatically fill it. You'll have a row of patterns 
filled with the chord of C.

Select the Arrow tool and click on the first pattern. A set of parameters will appear in the 
Information line.

Click on the Style box and a list of Styles will pop up.

Select the Disco pattern. Now click on the Chord box and select F. This is the root of the 
chord.

We want the chord of F major and Maj is already selected in the Type box so we can leave 
that alone.

Click on the second chord pattern and set that to F in the same way. When you get to the 
next chord, A7, select 7 in the Type box.

Carry on entering chords until you reach bar 7. We need two chords in this bar so we have to
split the pattern in two. Click on the Chord Snap box and set it to 4. Select the Knife tool and 
cut the pattern in two and then set the chords as before.



The second set of patterns in the same as the previous set - not including the very first 
pattern which is used for an intro - so select all the patterns, hold how Control and drag 
them to the start of bar 9.

Now click in another four pattern - set Chord Snap back to Bar - and change the chords in 
them. The final six bars are the same as the set you copied earlier so select them again and 
copy them to the start of bar 19. 

Select an instrument such as String Ensemble on Track 1 and set it to record. Click on the 
Record button and record the melody as the accompaniment plays.

You may find that the Chords track is rather loud in comparison with the more gentile 
melody line you're trying to play. That's because the accompaniments have been created 
with high velocities - to give you the opportunity to turn them down if need be.

Open the Mixer and you'll see that the accompaniment is using MIDI channels 10 to 15. The 
accompaniments have built-in sets of sounds, reverb, chorus and pan settings, and volume 
levels and these will be reflected in the Mixer - providing the Song data to mixer box is 
checked in the Mixer Settings... window.

It's no use changing the settings in the Mixer as the settings in the track will override them. 
The easiest way to change them, certainly on a temporary basis, is to reduce the velocity in 
the Vel column.

Now that you've recorded the melody and chord line, try selecting different Styles. Because 
the chords are the same, the styles will still fit the melody line although some of them may 
sound a little strange! The Waltz, in particular, as it's in 3/4 will sound decidedly odd. The 
timing will seem to be out but the chords will till fit.

Arranging the Chords tracks

Put the Style back to Disco and select the first chord pattern. 

Each pattern contains six instruments which you can switch on and off by clicking on the 
LEDs in the Information Line.

The first two bars are an intro so lets remove the accompaniment parts leaving just the bass
and drums. Click on the Acc1, 2, 3 and 4 LEDs to switch them off.

The next section is repeated so let's build up the accompaniment slowly. Select the first 
pattern in the section, bar 3, and deselect Acc3 and 4. Do the same with the patterns in bars
4 to 8.

Realtime Style Playing

Before recording a style chord track you should rehearse your chord changes. To do this, 
click on the active button on the screen keyboard and when ready to play click on any of the
notes in the active region. Unless loop mode is on the style will continue to play until the 
stop button is pressed.
When in SFC mode, the lower octave of your external keyboard will be used to change the 
chords. To play a major chord, play the chord note on your keyboard. To play a 7th chord 
such as    a C major 7th    (this will add the seventh note above C which is a B flat),    you need
to hit the C note plus the first white note beneath it. This would be true for any chord. To 



play a minor chord you would need to play the first black note beneath the chord note. A 
minor Major 7th chord is possible by playing the white and the black notes beneath the 
chord note.

Major Chord Note only
Minor Chord    note & first white

note below
7th Chord note & first black

note below
Min Major 7th Chord note plus first white

& black notes below

Realtime Chord Track Recording

If you'd prefer to lay down a chord track in real time rather than having to insert each 
pattern individually, then EVAP will allow you to do just that.
To record chords in realtime you will have to turn on the Hold, Synchro and Active buttons on
the keyboard window. Then, just as you would with any MIDI channel, enable the chord track
for recording by pressing the button in the record column.
Choose your style and then hit the record button on the transport bar. This will (if selected of
course) start the metronome count-in. Play the single fingered chords on the first beat of the
bar. You can play the Single Fingered Chords from either an external keyboard such as the 
Evolution MK-149, the PC Keyboard or from the on-screen keyboard.

Press stop to finish your recording. On playback, the chord track will play the chord patterns 
displayed in the chord track unless other chords are played "on top". The styles will always 
play the chord patterns displayed if "Active" is turned off.

When playing a chord using 2 or more keys of your external keyboard,    hold down the keys 
for the duration of the chord before playing another chord. This is not necessary for Major 
chords.

Using the on-screen keyboard to record chords in realtime

You can use the on-screen keyboard to record your chords in realtime. To do this, enable the 
Hold, Synchro and Active buttons and then click the mouse on any note in the bottom octave
of the keyboard. The active region is coloured blue. To change the chord type you must 
select the type (e.g. aug or sus4) from the 12 boxes on the right hand side of the keyboard 
window.

Using your QWERTY keyboard to record chords in realtime.

To do this you should enable the "PC keyboard" option on the screen keyboard and then 
record the chords as you would do using the mouse. See the keyboard window for more 
information on how to use the PC keyboard to input Single Fingered Chords. To access the 
lower octave by using the QWERTY keys you must hit the "Scroll Lock" key on your keyboard.
(It is usually situated on the top row).



The Conductor Tutorial
The Conductor window is where you set and change the Time Signature, Key Signature and 
the Tempo.

Load BRAHMS.SNG. This is one of Brahms' Hungarian dances. Play it through you'll notice 
that it slows down and speeds up a lot. That's where a lot of its excitement comes from. 
Open the Conductor window.

The squares with the red dots in them are Conductor Points and these indicate places 
where a tempo change occurs. The tempo is shown down the left of the window. The 
Conductor window is very friendly and automatically resizes its contents when you resize it.

Try it now. Grab the bottom right corner of the window and drag it up and down and you'll 
see that the tempo markings and the Conductor Points change size automatically in order to 
fit into the window. This is very useful if you want to see the Conductor as well as other 
windows which restrict the information you can see if you make them smaller.

Adjust the window until it's a comfortable size and play the piece. Keep an eye on the Play 
Position line in the Conductor. You'll see that as it passes over the Conductor Points the 
tempo speed up or slows down. If you can keep your other eye on the Tempo box in the 
Transport window you'll see the tempo change when the Play Position passes a Conductor 
Point.

Close the Conductor and click on the Conductor icon in the Transport window to deselect it. 
This deactivates the Conductor. Now when you play the piece you'll see how flat and lifeless 
- and boring! - it is. Switch the Conductor back on.

Note, you don't have to switch the Conductor icon on when you open the Conductor window 
as it is automatically activated when you open it.

Select all three tracks in the Tracks window and open the Score editor. You'll notice that 
there are a lot of sharps in the note display. That's because the piece is in the key of A and 
the Conductor is still in its default state and telling the program that it's in the key of C.

Open the Conductor and click on the Key Signature Display to highlight it.

Two entries will appear in the Information Line. The Position will show the time in the 
song that the Key Signature occurs - in this case it begins right at the start at 1:01:000. The 
Key box confirms the Key Signature as being C.

Click on the Key box with the right mouse button and the Key Signature will change. You'll 
see the changes taking place as you do so in the Score Editor. Set the key to A and most of 
the sharps will disappear. The piece is actually in F# minor which has the same key 
signature as A.

The Time Signature is not right either. It should be 2/4 but it appears as 4/4/. Select the 
Time Signature Display and the Position and TimeSig boxes will tell you the Time 
Signature and when it starts. Click in the TimeSig box with the left mouse button to reduce it
to 2/4. You'll see the score display change as you make the adjustment.

Let's say that you'd like to speed up the piece. Click on the highest Conductor Point in the 
first group. It will turn black to show it's highlighted



Its timing position will appear in the Position box and its tempo in the Tempo box. You can 
alter the Point in several ways. If you click on the Position or Tempo values, they will scroll to 
new ones. You can also click and drag the Conductor Point to a new position. When you 
release the mouse button its new values will appear in the boxes.

Remember, you can undo the last value change by selecting Undo from the Edit menu or 
pressing Ctrl+Z.

You can change several Conductor Points at the same time by clicking and dragging a lasso 
around them or by Shift-clicking on them.

If you want to add new Conductor Points, right-click in the window, select the Pencil tool 
and click new Points into the window.

You can also create new Point by holding down Ctrl while you drag a point. This makes a 
copy of the Point and places it at the position where you release the mouse button.

You can insert new Key and Time Signatures, too, very easily by clicking in the Key Signature
and Time Signature Displays with the Pencil.

You can select each entry individually and change it with the mouse buttons. To remove an 
entry or one of the Conductor Points, click on it with the Eraser.



The Drum Editor Tutorial
The Grid
The Information Line
Adjusting drum velocities
Hit colours
Creating a rock pattern
Building a drum track from patterns
Editing Child and Parent patterns

They say that the musicians who write the best drum patterns are drummers. That may be 
true but EVAP's Drum Editor makes drum pattern programming easier for everyone and it 
can help you be more creative.

Load the TECHNO.SNG file, highlight the first HiHats pattern and click on the Drum Editor 
icon.

The Drum Editor uses a programming method similar to that used by most stand-alone drum
machines. The Drum Display on the left lists the drums which are available in the current 
drum kit. Drum kits can be easily customized and loaded and saved. There's more about this
in the Reference section.

The right of the window is the Hit Display. A grid divides the bars into subdivisions of the 
beat and drum hits - the LEDs - are placed on the grid. Like the Track window, the two 
sections are separated by a Divider which you can drag left and right.

The Grid

You can adjust the resolution of the grid with the Grid selector. First of all, use the Zoom 
button so the two bars fill the display area. Set the Grid to 16. The hi hat hits fall exactly on 
the grid lines. Now set the Grid to 32 and the number of grid lines will double.

Now set it to 64. You probably won't see any change. That's because the display 
automatically adjusts itself to the current zoom setting. If the program were to draw 1/64th 
note lines in between the 1/32nd ones, the display would be incredibly difficult to read.

Click on the Zoom In button. You'll probably have to click on it twice and a single bar fills the 
display area you'll see the 1/64th beat divisions appear.

Zoom out again and set the Grid to 8. You'll see that the Closed HiHat hits are no longer on a
grid line. Click and drag one of them and move it slightly left or right, just a little. When you 
release the mouse button, the hit will snap to one of the grid lines.

As well as displaying beat divisions, the Grid makes sure that the hits you enter fall squarely 
on the grid lines. The grid makes it easy to visualize the rhythm which helps when 
constructing drum patterns.

To put the pattern back to its original state, click on the Recall button and the pattern will 
revert to the way it was before you opened the Drum Editor.

Start playback. When the song reaches bar 3, the Play Position Line will appear in the editor 
window and move across the display. If you want to listen to the contents of the editor 
without the distraction of the rest of the song, click on the Edit Solo button.



The Information Line

Click on one of the hits and look at the Information Line. This gives you exact information 
about the hit and you can alter any of the parameters by left and right clicking.

Close the window by clicking on the Close button, select the Tambourine pattern and open 
the editor again. EVAP allows you to have several editors open at the same time but we'll 
work with one at a time at the moment to avoid any possible confusion.

Adjust the window and the zoom setting so you can see the two bars of hits. Set the Left and
Right Locators to the start and end of the pattern - if you're using the original TECHNO.SNG 
file this will be bars 5 to 6. Make sure the Edit Solo button is on and start playback.

You'll probably be able to hear that the hits are not all the same volume. If it isn't obvious, 
try the following. Select the first Tambourine Child pattern in the Track window and click on 
the Drum Editor icon. This will open a second Drum Editor window.

Set the Left and Right Locators to encompass both patterns - in TECHNO.SNG this will be 
from bars 5 to 8 - and switch on Cycle mode. Right-click in the Display area to open the 
Toolbox.

Adjusting drum velocities

The Velocity Modifiers and the Drumstick tools are unique to the Drum Editor. The 
Velocity Modifiers increase or decrease the velocity of a hit by 10. The Drumsticks are used 
to enter hits onto the grid.

Select the Up Velocity Modifier and click on each of the hits in turn until they turn purple. If 
you click once too many times, the hit will turn red. No problem. Select the Down Velocity 
Modifier and knock it back down to purple.

If you want to hear the drums as you are entering them, click on the Speaker Switch:

When it's on it will transmit the hits and changes you make to the hits via MIDI. When it's off,
it won't but the hits will still sound during playback.

Solo the track in the Track window and click on play. You'll hear the original pattern followed 
by a pattern whose velocities are all the same. The hits on the beat are louder than the 
others and the different velocities give the original pattern a rhythmic pulse. The second 
pattern has no velocity variations at all and is rather flat, lifeless and robotic. You should aim
to build velocity variations into your drum patterns as this will make them sound more 
human and interesting.

Hit colours

EVAP uses colours to represent velocity values. Each colour represents a change in velocity 
of 10. However, the colours don't represent absolute velocity values, rather they are relative
to the initial velocity value set in the Vel column. Let's see how this works by constructing a 
drum pattern.

Select New from the File menu. The program will tell you that the song has changed and ask



if you want to save it. You don't as that would overwrite the original file so click on No.

Select the Pencil tool and click a pattern onto track 10 at bar 1. If Snap is set to Bar, clicking 
close to the start of bar 1 will do the trick. The pattern will be highlighted so click on the 
Drum Editor icon to open it.

Select the Large Drumstick. This clicks hits onto the grid at a velocity determined by the 
value in the Vel column. It defaults to the maximum velocity of 127. Click a few hits onto the
grid and they'll be red.

Add some hits with the Small Drumstick. This enters hits at a the default velocity minus 10 
less and the colour purple. Click on the hits with the Arrow and check their velocities in the 
Information Line.

Now select the Down Velocity Modifier. Click on a red hit and keep clicking until it turns light 
grey. The hit will cycle through the following colours and have the following velocity values:

Red                127
Purple          117
Blue              107
Green              97
Dark Cyan      87
Dark Grey      77
Grey                67
Light Grey    57

Further clicking will continue to reduce the velocity by 10 each time but the colour will stay 
the same.

Select a drum which doesn't contain any hits and reduce the value in the Vel column to 107. 
Now click a couple of hits in using the Large and Small Drumsticks. The colours will be red 
and purple respectively because they are relative to the Velocity setting. In other words the 
red hit is at the maximum default value and the purple hit is 10 below.

Now scroll the Vel value up to 108 and the colours change to purple and blue. You've 
increased the default value so the first hit is no longer in the top 10 so it drops down a 
colour. Scroll up and down through the Vel value and see how it changes the colours.

The system works with relative values rather than absolute values to enable you to balance 
the sounds in a drum kit. For example, a deep snare drum with reverb will probably be much
louder than a triangle. You could, therefore, reduce the default velocity of the snare to a 
suitable level so when you click in hits they will be balanced with the rest of the kit.

If you're using a General MIDI sound source, the default values will be fine in most cases.

Creating a rock pattern

We'll use the Drum Editor to create a rock pattern. Close the Drum Editor and delete the 
pattern you've been experimenting with from the Track window. Use the Pencil to draw in a 
two-bar pattern on track 10 and open the Drum Editor again.

Let's start by creating the bass and snare lines. Turn Cycle on and set the Left and Right 
Locators to cycle between bars 1 and 2. Adjust the zoom so these two bars fill the display 
area and set the Grid to 16.



Click on play and you will hear the pattern play as you build it up. You may prefer to switch 
the Speaker Switch off to prevent the sound of the hits you are entering from playing and 
disturbing the flow of the pattern.

Click bass and snare hits onto the grid with the Small Drumstick. You can make up your own 
pattern.

Add a 1/16th note hi hat line on Closed HiHat. Add an Open Hi Hat on the second last 1/16th 
on bar 2 to create a little lift. We need to add some accents to give the pattern a little feel so
use the Up Velocity Modifier to increase the velocity of all the snare hits, the hits on beats 1 
and 3 in both bars and the Open Hi Hat.

You may feel the difference between the two velocities is not great enough so use the Down 
Velocity Modifier to reduce the hits which aren't accented.

If you like what you've created, save it.

Building a drum track from patterns

An easy way to build up a drum track is to construct a few patterns and copy them in the 
Track window. You probably won't want the same two-bar pattern to play throughout an 
entire song so you can modify it slightly.

Close the Drum Editor and in the Track window, Control-drag the pattern onto bars 4 and 5. 
Unless you've altered the Preferences settings it will be a Child pattern with a dotted outline.
Select it and open the Drum Editor.

Editing Child and Parent patterns

Add some extra hits to the pattern. At this stage it doesn't matter what you add. Now click 
on the Close button and a dialogue box will appear asking if you want to convert the pattern 
into a Parent pattern.

If you say Yes, it will become a Parent pattern in its own right. However, if you say No, the 
original Parent pattern will be changed and become the same as the Child pattern you've 
just edited, and all its Children will be altered accordingly to reflect the changes.

This is a logical consequence of the Parent/Child relationship. As a Child has the same notes 
and events as its Parent, you cannot change its contents because it would then cease to be 
a Child.

If you edit a Child, EVAP assumes you want to do one of two things - edit the Parent or create
a new, original pattern. Perhaps you're working at the end of a song and the original Parent 
is near the beginning. Editing a Child saves you scrolling through to the start and if you 
select the No option, the program will helpfully edit the Parent for you.

Alternatively, you may want to modify the pattern at that position in the song but leave the 
Parent and its other Children alone so you would say Yes to convert the Child into an 
independent pattern.



The Event Editor Tutorial
The Display Filter
Editing selected events
Editing System Exclusive messages

The Event Editor shows data in a list. It's the nearest you want to get to viewing raw MIDI 
data - and it's some way off that! However, it gives you very precise control over every 
aspect of your music. In many ways it's the most powerful of EVAP's editors although you 
won't want to use it all the time.

Each editor has a range of functions it excels at and the Event Editor is ideal for:

* Viewing all events and seeing where they are in relation to each other.

* Adjusting events' values and timing with extreme precision.

* Entering and editing System Exclusive data.

Load EVENT.SNG which is the first few bars of the lead string part in Vivaldi's Spring from 
The Four Seasons. Select the pattern, open the Event Editor and play it. It probably sounds 
okay although there is a glitch at the beginning of the third bar.

The Display Filter

Examine the part in the Event Editor. The main body of the display shows the MIDI events in 
the pattern. Above them is the 
Display Filter which hides certain types of event from the display.

Switch all the filters on so they are black rather than grey and you will see all the MIDI 
events in the pattern. By switching the filters on and off you will see that there is Note, 
Controller and Bend data in the pattern.

You can select any event simply by clicking on its name. Note that the last three column 
heading change according to what event is currently selected. If you highlight a Note, for 
example, the last three columns tell you the Key (note name), Velocity and Length. Select a 
Controller and you'll see its number and value.

Let's sort the chaff from the wheat. We'll start by getting rid of the glitch. Switch the 
Controller display off so you can see just the Note and Pitch Bend data. Look at the two sets 
of Bend data. It appears that they should be the same but the first set has acquired a few 
extra instructions which boost the pitch causing the glitch.

Highlight the offending entries - the ones with 124 and 116 values. You can do this by 
clicking and holding on one then dragging the mouse to the other or by Shift-clicking on 
each event. This process allows you to select non-consecutive events.

Now click on the Delete button at the top of the window or press the Delete key on your PC's
keyboard. The two events will be removed.

Does that sound better? If you're not sure, use the Undo and Redo functions to compare the 
pattern before and after. You could also click on the Recall button. This restores the 



pattern's original contents to the state they were in when the editor was opened. If you close
the editor then any changes you made are stored.

Recall is a very useful function because if you make a complete pig's ear of an edit, you an 
easily go back to the original state. Likewise, if you have made an edit you're happy with, 
you can close the editor and open it again and the edit will be saved. There's a Recall button
in all the editors.

Editing selected events

We sorted out the Pitch Bend so click the Bend filter off and switch the Controller on. There 
are a lot of Volume instructions here. Are they really necessary? And what effect do the 
Modulation instructions have?

Let's try a quick and dirty test. Switch the Note filter off so you only see the Controllers. 
Choose Select All... from the Edit menu and delete the selection using one of the methods 
described above.

Now play the piece and use Undo and Redo to compare the two versions. Put the pattern 
into Cycle mode if you wish. You'll hear that the Volume instructions do make a difference by
subtly changing the volume of the notes as they are sounding. Perhaps the programmer 
should have used Expression instead of Volume (see the Appendix for further information 
about these two Controllers) but otherwise a lot of thought has gone into making the piece 
expressive.

What of the Modulation instructions? Do these have a noticeable effect on the notes? You 
can use the same procedure to remove them from the pattern and find out.

Editing System Exclusive messages

Open the GM_REST.SNG file and look at the pattern in the Event Editor.

Not much to see, is there?

System Exclusive messages have a number of uses. One of the most common is to put a 
unit into a certain mode such as GM, GS or XG (there's more about Sys Ex messages and 
General MIDI in the Appendix). It's also used to edit synthesizer voices but that requires a 
dedicated editor and is beyond the scope of EVAP and this manual.

However, because of their flexibility, Sys Ex messages can contain any amount of data. 
Unlike a Controller message which has a Controller Number and a Value, a Sys Ex message 
could contain several dozen - or even a few hundred - bits of data.

Rather than try to show all this in the Event Editor, EVAP simply tells you that there is a 
Sysex event there and if you want to see it in more detail double-click on it. 

This is EVAP's System Exclusive Editor where you can edit and create Sys Ex messages.



The Fast Menu Tutorial
The Fast Menu is a very useful feature designed to save you time. You can program it with 
the ten functions you use most often and to call a function you simply click on its button in 
the Fast Menu.

If you can't see the Fast Menu on screen, select Show Fast Menu from the Window menu.

To customize the Menu with your top ten items, select Configure Fast Menu... from the 
Windows menu.

The items on the right are the ones which are currently in the Menu. To remove one, 
highlight it and click on the Delete button.

The list on the left shows the functions which can be placed in the Menu. To add one, 
highlight it and click on the Add button. If there are already ten items in the list, the Add 
button will be greyed out.

To change the order in which items appear in the Menu, highlight one and click the Up and 
Down buttons to move it through the list.

The default set of items may not be ones you use the most. You have now worked your way 
through most of EVAP's major functions and if you found yourself using certain commands a 
lot, put them in the Fast Menu.

You may find that when you are working on certain songs or certain styles of music, you tend
to use some functions more than others. If that's the case, reconfigure the Fast Menu as you 
go. It only takes a few seconds and it will ensure that the commands you use most often are 
readily available.



The Mixer Tutorial
Recording Mixer movements
Taking a Snapshot

EVAP's Mixer is the computer equivalent of a studio mixing desk. It lets you balance the 
volume levels of the instruments in your music, adjust their pan positions, and set reverb 
and chorus levels. You can also use it to record a live mix so the changes you make are 
recorded into your music.

The Mixer has 16 channels for each MIDI output in your system. These are listed just below 
the Title bar and you select one by clicking on it. The name will highlight by turning blue to 
show that it is the currently-selected mixer.

If the Output has not been selected in the Devices... menu, the mixer will be grey and you 
will not be able to move any controls. If the device is an active one, the mixer will be 
coloured.

The mixers are all part of one long window and you can scroll through them to reach the one
you want. However, a much easier method is to select the Output and then click on the Auto
Size button.
This resizes the window so the one set of 16 channels fits the window exactly.

Each channel is exactly the same

Working from the bottom up, first there is a Volume fader. The text beneath can show the 
Track or Patch names or simply the word "Volume". These options are set from the Mixer 
Settings... window which is described in detail in the Reference section.

To the right of the slider is a meter which shows when notes on that MIDI channel are being 
transmitted. It responds to the velocity data of the notes, not volume data, so you can see 
which channels music is being transmitted on. This can also help with troubleshooting. If a 
particular music line is not sounding, you can confirm that it is actually being transmitted. If 
you Mute the channel, the meter will be muted, too.

Next up are Mute and Solo buttons. These work exactly like the Mute and Solo buttons in 
the Track window.

The Pan pot places the sound in the stereo image. Obviously, you need a stereo output in 
order to hear this.

The next two pots are user-definable and can be set to control Pitch Bend, Modulation, 
Expression or a number of other MIDI controllers. The settings are made in the Mixer 
Settings... window. When you first start using EVAP they will probably be set to Reverb and 
Chorus levels.

To adjust one of the rotary pots, click and hold on it and drag the mouse up and down.

Above the pots is a Flat button which sets all the controls on that channel to maximum or to
centre positions. You can flatten any individual control by holding down Ctrl and clicking on 
it. This is useful if you want to make sure a Pan pot is centered, for example.

The numbers at the top indicate the MIDI channel and cannot be altered.



There's just two more buttons to look at.

The All Flat button flattens all the controls in all of the channels.

When you click on the Snapshot button, it transmits the values of all the knobs and faders 
via MIDI. If you are recording and the Record mixer movements box in the Mixer 
Settings... window is checked, the values will be recorded. This is a good way of storing 
settings into a song.

Recording Mixer movements

Let's have a bit of fun and do some practical mixing in the process. Load the BUMB_B1.SNG 
file which is The Flight of the Bumble Bee. Open the Mixer Settings... window form the 
Options menu and make sure the Song data to mixer and Record mixer movements are
checked.

The first makes the Mixer respond to Volume and Controller data which is in the song. The 
second records changes you make in the Mixer, providing you're recording at the time.

Play the file and watch the Mixer. You won't see anything exciting happening because there's
no Controller data in the files. Let's make the bee buzz around a bit.

Click on the Add MIDI Track icon in the Track window.

Activate the Record button in the Rec column. If there's no Rec column, select it from the 
Select Track Columns window as described earlier. Set the Track's MIDI Channel to 0. Click on
the All Flat button in the Mixer and then on the Record button in the Transport window.

Now, any Mixer movements you perform will be recorded into the track. Click and hold on 
the Pan pot in channel 1. This contains the melody so move the "bee" around from one side 
of the stereo image to the other. You can be as wild and erratic as you like but for a more 
artistic interpretation you might like to try smooth movements from one side to the other to 
imitate a "flight" rather than a jump!

Play it back and you'll see the Pan pot move in response to the Pan data.

Create another MIDI track, click its Rec button, set its MIDI channel to 0 and use it to record 
movements for the second violin part. As this is not so busy, you may like to be a little more 
restrained with it.

Save the song. Use a different name such as MYBEE. If you want to see one we prepared 
earlier, load at BUMB_B2. Select the first track and open the Piano Roll Editor. Select Pan in 
the drop-down Display menu and you'll see the pan data in the Velocity Display section of 
the window.

There is probably a lot less of it than in your piece. That's because it has been thinned using 
the Thin Out Continuous Events... function. You might like to thin out the data in your 
Bumble Bee song. This procedure was explained in the Piano Roll Tutorial.

While you're in the Piano Roll Editor you might like to try another way of recording the Pan 
data and that's to draw it in to the Velocity Display.

Taking a Snapshot



After creating a piece of music, you may decide you only need to use one set of parameters 
for the whole piece. Instead of entering this data into the Event Editor, you can create the 
settings in the Mixer and save them directly to a track by taking a Snapshot.

Load the GAUDETE.SNG which is an old Christmassy choral work. Flatten the Mixer and play 
it. If you have better voice and choral sounds than those in the standard GM set then by all 
means use them.

However, you can improve the GM sounds by adding reverb and chorus and you can make 
the piece more interesting by spreading the voices around the stereo image. Make sure the 
top two user-definable pots are set to Reverb and Chorus. If they aren't, use the Mixer 
Settings... window to make them so.

Play the piece and adjust the Reverb and Chorus settings. Adding reverb will make the voice 
appear to be in a large hall - it can add considerably to the Cathedral effect. Adding Chorus 
thickens the sound.

Give each voice its own position in the stereo image. You may like to pan the highest one to 
the right and place the lower ones further to the left or you could pan the two highest voices
fairly well left and right and place the two lowest ones in between them.

When you have a mix you like, add new track as you did before, click on its record button 
and set it to MIDI channel 0. With EVAP recording, when you click on the Snapshot button, all
the Mixer settings will be recorded into the track.

Obviously, you want these to occur before the first note so you have to click on Record in the
Transport window and then on the Snapshot button after the count-in has finished but before
the first note has sounded. That's pretty difficult because the first note actually occurs on 
the very first beat of the bar. In fact, it's impossible!

It's common practice among those who create MIDI files to leave the first bar free for 
setting-up data. It's not just a question of squeezing all the data in before the first note. 
Some instruments take a short while to initialize after receiving certain types of information 
so you want to make sure they are correctly prepared for the music to avoid a glitch.

That's easily done in EVAP. Select all the tracks in the Track Editor, either by lassoing them 
all or by selecting Select All from the Edit menu. Make sure Snap is set to Bar and drag them
en mass slightly to the right where they will snap to the second bar. If this isn't easy to see, 
zoom in until the bar lines in the Timeline are clear.

Now you have a full bar in which to click on the Snapshot button. But don't take too long - do
it as soon after the count in as possible.

Switch on the metronome in the Transport window to help you. Are you only getting a two-
beat count in? Check the Metronome Settings... window and look at the Count in Bars 
section. Does the count in say 1 bar? And you're still only getting two beats count in. That's 
because the piece is in 2/2 time which only has two beats to the bar. Check it out in the 
Score Editor or the Conductor.

Change the Count in Bars to 2 and you'll get four clicks count in. The Metronome Settings... 
window is described in detail in the Reference section.

Here's a sort of negative tip. If you click on the Snapshot button during the last two beats of 
the count in, the data will still be recorded but it will be moved to the first beat of the bar - 



all of it! Try it.

Now, if you absolutely must start the music on the first beat, this is a good way to get your 
setting up data in there, too. You would need to move any notes which actually occurred at 
position 1:01:000 to a slightly later time position to avoid any glitches.

MIDI is a serial transmission protocol (there's more about this in the Appendix) which means 
it can only transmit one item of data at a time. If there is lots of data on the same time 
positions, they are still sent out in a queue. If there is a lot of data, this could cause a time 
delay or a glitch. The moral of the story is to avoid these situations as much as possible if 
you can.

It's a good idea to delete any data which was not required. With this piece that would be all 
the data on channels 5 to 16. In fact, purely in the interests of tidiness, economy and clarity 
it's a good idea remove all surplus data from your sequences.

This is easy to do in the Event Editor - just click and hold on the first event on channel 5, 
drag downwards to select all following events and then delete them.

However, if you want the piece to play correctly on any instrument you would also want to 
include a GM, GS or XG Reset message along with other Controller messages to set the Pitch
Bend range, centre the Modulation wheel and so on. Some instruments can take a while to 
respond to a Reset message - a "while" in MIDI terms may only be several milliseconds but if
the instrument receives a Note On message during that time it may not play correctly - so 
you need to give an instrument time to set itself up.

Now, assuming you have recorded the data after the first beat, take a look at it in the Event 
Editor.

You'll notice that the data for each channel has been separated by six or seven ticks (ticks 
and timing positions are fully explained in the Reference section). This ensures that the 
sequencer does not try to transmit all the data at once which is a "good thing" as we 
discussed earlier.



The Piano Roll Editor Tutorial
Quantisation
Partial Quantisation
Changing note lengths
Music for monophonic instruments
The Velocity Display area
Viewing MIDI Controller data
Editing Pitch Bend
Thinning Controller data

The Piano Roll Editor is the note equivalent of the Drum Editor. The Note Display area 
shows notes as rectangular bars on a grid against a keyboard on the left which indicates 
pitch. It takes its name from the Pianolo rolls of yesteryear which consisted of rolls of paper 
with punched holes which triggered the keys on an specially-adapted acoustic piano.

Load the PIANOROL.SNG file, select the pattern and open the Piano Roll Editor. Adjust the 
window so you can see all four bars in the display. Use the Vertical Zoom In and Out buttons 
to set the display to a comfortable size.

Most editing takes place on the horizontal plane rather than the    vertical one so it's not 
necessary to have a really deep display.

Like the Drum Editor, you can change the grid resolution with the Grid Selector and if you 
set too fine a resolution it won't show in the display until you zoom in. The shortest notes in 
this pattern are 1/16th notes so set the grid to 16.

Activate Cycle mode and set the Left and Right Locators to cycle through the pattern. Listen 
to it closely. You can probably hear that the timing is a little less than perfect. Look closely at
the notes. To be in perfect time, the beginning of each note should sit squarely on one of the
grid lines. Very few do and some are as much as 1/32nd out. You may want to zoom in a little
to see this better.

You can put this right in two ways - you can adjust the notes manually or you can apply 
some quantisation.

Quantisation

Quantisation is the process of pushing and pulling notes onto certain divisions of the beat, 
basically to correct sloppy timing. It's one of the great functions you can perform with a 
sequencer but it has been much overused - and still is.

Quantisation can produce note-perfect timing but the trouble is, even the greatest musicians
in the world don't play with such precision. The fact is, it's the small timing differences in a 
performance which make it sound interesting. So, use quantisation by all means but don't 
regard it as a universal panacea for poor playing and timing or your songs will turn out 
mechanical.

Lecture over. Let's see what we can do to tidy up this bass line.

Look at the grid and you can probably see that the lowest notes are supposed to occur on 
the beat, the highest notes in between the main beats and the middle notes on the beat a 
sixteenth before the main beats.



The lowest notes are fairly accurate so we'll leave them alone for the moment. The highest 
notes aren't too bad, either although a few are a little late. Some of the middle notes, 
however, particularly in bars 2 and 3 are almost a thirty-second late. Let's try to sort those 
out first.

We'll quantize the whole set of middle notes en mass. Drag a lasso around them so they are 
all highlighted. Select Quantize... from the Procedures menu and set the Quantize 
Setting to 16.

Partial Quantisation

The Quantize routine usefully allows you to perform a partial quantize which is expressed as 
a Percentage Change. A full quantize will move a note onto the nearest specified division 
of the beat, in this case to the nearest sixteenth division. However, a Percentage Change of 
50, say, would only move it half way towards the division. This improves the timing but 
doesn't make it perfect so there is still some "human feel" left.

We'll go the whole hog and use a setting of 100 percent!

Click on OK and watch the notes - they'll jump to the nearest grid division. But see what's 
happened - some of them have moved the wrong way! Play the pattern now and it'll sound 
worse than before. That's because some notes were so far out of time they were moved onto
the wrong division.

However, it's easy to see where the notes should be. The culprits are on the first beat of bar 
2 and the first beat of bar 3. Deselect the notes by clicking on an empty part of the Display 
area and, with the Arrow tool, drag the two notes back a sixteenth.

Whoops! There's still a note in the middle of bar 2 on the wrong beat. Drag that back a 
sixteenth, too. No, there's still another one. Can you spot it? You'll certainly be able to hear 
it. Put that right, too. Now what does it sound like?

Well, there's still some poor timing in bars 2 and 3. Let's try quantizing the highest notes in 
these two bars only. Drag a lasso around them, select Quantize... and set the Percentage 
Change to 50.

No, we've got the same problem. One of the notes is so far out it's being pulling onto the 
wrong beat. Drag it onto the right division.

The timing is better but it still sounds a little raggy. That's because even though the timing 
of the original recording was pretty poor, the performer (who shall remain nameless!) was 
still playing with a sense of rhythm. By quantizing selected sections we have destroyed that 
rhythmic relationship between consecutive notes.

But we can fix it. Choose Select All from the Edit menu. All the notes will highlight. Now 
quantize them all with a Percentage Change of 50.

There!

Zoom in and examine the notes. They have been pulled nearer to the beat they are 
supposed to be on but, because we used partial quantisation, they are not "note perfect" 
and still retain a little human feel.



Now try applying 100 percent quantisation to all the notes. You'll see them move on the grid 
but can you hear the difference? Use Undo and Redo in the Edit menu to flip between the 
two versions. There's not much in it, is there? Without getting into the realms of 
psychoacoustics, the small variations in the partially quantized piece will sound slightly more
interesting to the listener, especially if an entire piece of music is partially quantized rather 
than fully quantized.

Changing note lengths

We can experiment further with this bass line. Save the partially quantized pattern so you 
can retrieve it again if you change it beyond recognition through editing.

Start Cycle playback as before, select all the notes and select Change Lengths... from the 
Procedures menu. The pattern consists of 1/8th and 1/16th notes. Let's see what happens 
if we change them all to 1/16th notes.

Click on the Fixed Length button, set it to 16 and click on OK. The timing has not changed 
but the 1/8th notes are now shorter and the pattern will sound staccato.

Undo that and apply a Fixed Length of 8. The line will now have many overlapping notes and 
will have a sustained effect.

Undo this and then try Remove Overlaps. You'll see the top set of notes in particular 
shorten. The line will sound smoother, not as clipped as the staccato change, but we have 
lost the sustain effect of the overlapped notes.

Music for monophonic instruments

Which do you prefer? Because of the overlap, the original has more depth, especially when 
played using a piano sound. However, removing overlaps can be useful if you are trying to 
create an authentic sound using a monophonic instrument, that is one which can only play 
one note at a time such as a trumpet or violin.

You can see how effective this is by playing the line using different sounds. You don't have to
stop playback, simply select Patch Lists... from the Options menu and single click on 
various instruments.

The Velocity Display area

Below the Note Display is the Velocity Display area. At the moment it contains vertical lines 
which represent the velocities of the notes above them. When you highlight a note its 
velocity highlights, too, and vice versa. You can highlight a velocity by clicking on it or by 
lassoing it. The lasso must completely encompass the velocity bar.

You can move a note by dragging its velocity left or right. This method does not allow you to 
move a note up or down and so change its pitch and it's useful if you want to adjust the 
position of a note and you're working on a grid which is zoomed out vertically.

You can edit the Velocity with the Cross hairs cursor. Right-click in the editor window to call 
up the Mouse Tools Selector and select the Crosshairs.



Moving this across a velocity bar will change the value according to the vertical position of 
the Crosshairs. This is a very easy way to adjust the velocity of a note.

You can also drag the Crosshairs across a number of velocities to create a gradual increase 
or decrease in volume - not withstanding the information given earlier regarding the 
difference between Velocity and Volume data!

Viewing MIDI Controller data

The Velocity Display can show other types of MIDI controller data - all 128 types, in fact, plus
a few specialized controllers such as Pitch Bend and Aftertouch. There's a complete list in 
the Appendix.

They are selected by clicking on the arrow to the right of the Display box and then selecting 
the required controller from the drop-down menu.

You can try selecting other controllers but you won't see anything in the Display area 
because the pattern does not contain any other type of controllers.

Editing Pitch Bend

Load the PITCHBND.SNG file and look at the pattern in the Piano Roll Editor. Select Pitch 
Bend in the Display box. Set the program to Cycle between the three bars and start 
playback.

As the Play Position moves across the Piano Roll window you'll hear the sound of the guitar 
bending downwards as it reaches the Pitch Bend data in the display. The second note 
begins after the pitch has been lowered and so is affected by the Pitch Bend, too. Instead of 
playing its own pitch which is E, it sounds with a pitch of D.

Look carefully and you'll see a small red dot in the Display just after the second note ends. 
This is a Pitch Bend value of 64 which is the central position of a Pitch Bend wheel and 
effectively turns Pitch Bend off. If this small piece of data was not there, subsequent notes 
would sound a tone lower than they should which could cause all sort of problems.

You can edit the Pitch Bend data simply by dragging the Crosshairs across the Pitch bend 
data.

You can create new Pitch Bend data with the Pencil tool. Try drawing some curves into the 
display. Note that the Crosshairs only edits or shapes existing data while the Pencil creates 
new data.

You'll notice that the data you draw in appears in solid red as opposed to the lines of the 
existing Pitch bend data. This is because the original data has been thinned.

Thinning Controller data

Draw some Pitch Bend data into the display and activate playback. Now select Thin Out 
Continuous Events... from the Procedures menu. You can select the type of event you 
want to thin but as the only type in this pattern is Pitch Bend there's no need to select it 
specifically.



You do need to enter a value in the Delete one event in every box which determines how 
many events will be removed. Leave the setting at 2 which removes every other event, 
effectively halving the number. You'll see the solid block change to lines. Listen to the 
playback and it's unlikely that you'll notice any difference.

You can apply additional "Thins" to the data, each time halving the amount, and you may be 
surprised at just how much data you can remove without it effecting your perception of the 
sound.

There are three reasons why you may want to thin out Controller data:

* As you have seen, there can often be more Controller data in a piece than is required. MIDI 
is a serial protocol which means notes and events are transmitted one after the other. Even 
events which are supposed to occur at the same time are transmitted sequentially.

It follows, therefore, that if there is a lot of Controller data, some events could be delayed 
considerably. In mild cases you may notice slight irregularities in timing. In extreme cases 
there may be a most noticeably hiccup. So, reducing the amount of Controller data can help 
preserve timing and ease the transmission load.

* Controller data uses memory and takes up space in a file when it's saved to disk so 
reducing it conserves both. In these days when 4Mb and 8Mb of RAM is commonplace, this is
not so important as it once was but if a piece contains a lot of Controller data the saving 
could be significant.

* Reducing Controller data to its essentials makes it easier to see and easier to edit.

With a little practise you'll find it's not too difficult to draw in a smooth Pitch Bend curve by 
hand although most musicians find using a Pitch Bend wheel more intuitive.



The Recording Tutorial
We've now looked at EVAP's main Editors so it's time to put everything together and record 
some music. This is the longest of the Tutorials but it brings together all the features you 
have already explored and it shows how to use them in a variety of ways which you'll do 
when creating your own music.

Rechannelising with MIDI Thru
Using Local Control
Metronome Settings
Setting the Tempo and Time Signature
Recording in real-time
Recording in step-time

We'll start from scratch. Select New from the File menu.

EVAP will give you the option of saving whatever you were previously working on and then 
give you a full compliment of 254 MIDI tracks with a Chords Track and an Audio Track at 
the top of the list. All the track parameters will be set to their default values which will be 
OFF or 0.

We'll record a bass line in real-time. Make sure the Rec button for Track 1 is on and you can 
see the MIDI and Patch Columns. If any of these is not showing, select it in the Select Track 
Columns box as described earlier.

Make sure your keyboard is properly connected and play some notes. If everything is 
working as it should, a red LED will flash in the MIDI column indicating that MIDI data is 
present on that channel. The indicator flashes for both incoming and outgoing data.

Rechannelising with MIDI Thru

A good way to set up your equipment is to rechannel the incoming MIDI data through the 
sequencer. This was described under the Record heading in the Select Track Columns section
of the manual but here's some more information.

If you are using a keyboard for recording but playing through a sound card or sound module, 
you obviously don't want to hear the sound the keyboard is producing. The solution is simple
- turn down the keyboard volume!

However, if you are using a keyboard for both recording and playback, you will have another 
adjustment to make. You want to be able to hear the keyboard, but not necessarily the 
current sound you are playing.

The solution is to put the keyboard into Multi-timbral or Combi mode. This allows it to 
play different music lines on different MIDI channels via MIDI. The manual will tell you how to
do this - it's usually just a matter of pressing a button or selecting an option from a menu.

Using Local Control

You also want to switch Local Control off. This effectively disconnects the physical 
keyboard from the sound-generating section. The keyboard will still play sounds but only 
hose arriving at the MIDI In socket. Most keyboards have Local Control and, again, you'll 
have to look in the manual to see exactly how to switch it off.



When you've done this, you will be able to play different sounds on the keyboard through 
EVAP without having to change the instrument or the MIDI transmission channel on the 
keyboard. You can select sounds from EVAP's Patch List window.

There's one other thing you have to check. Open the MIDI Settings... window in the 
Options menu and make sure the Thru Channel Messages box is checked. Also, make 
sure than none of the Message Filters or Channel Filters are checked. The MIDI 
Settings... window is fully described in the Reference section.

Once you have set up EVAP, your keyboard and sound card or module, you can begin.

Metronome Settings

You'll need a timing reference to play against when recording. Select Metronome Settings... 
from the Options menu and check that its settings suit you. It uses a Side Stick, MIDI note 
C#1, for the click but you can change this if you wish.

You can also select different sounds and velocities for the main beat and the sub-beats in the
bar. The default setting is to play the sub-beats with a lower velocity which we think is fine 
but do change it if you don't.

You can use the PC's speaker instead of MIDI for the Metronome output. You might want to 
do this while recording the drum tracks, for example. However, on some PCs the speaker 
may be rather quiet.

We also prefer to hear the Metronome only during recording so the Record Only box is 
checked. Finally, set the number of count in bars you require. Remember, if a piece is in 2/4, 
for example, a one-bar count in is only two clicks.

Now we're ready to begin. There may seem a lot of setting up to do but once it's done, EVAP 
will remember the settings.

Setting the Tempo and Time Signature

These default to 120bpm and 4/4. This piece is going to be a little faster so open the 
Conductor, click on the Conductor Point and change the Tempo to 132. 4/4 is fine.

You could have set the Tempo to 132 in the Transport window and deactivated the Conductor
but it's good practise to use the Conductor as it means any tempo changes you make are 
automatically stored.

Recording in real-time

Click in the Patch column of Track 1 and select a bass sound. We've used Syn Saw Wave to 
produce a thick, analogue-type sound. We're going to record a bass line:

The riff is in 1/8th notes so there are eight in a bar and each note is followed by the same 
one an octave higher which we'll indicate by the ^ sign. Start on a low D and play: (See page
101 of the help manual for the score view).

D    ^D    D    ^D    D    ^D    D    ^D        Bar 1



D    ^D    D    ^D    D    ^D    C    ^C        Bar 2
D    ^D    D    ^D    D    ^D    D    ^D        Bar 3
D    ^D    D    ^D Eb    ^Eb F    ^F        Bar 4

Practise it a few times until you're comfortable with it. Click on the Record button in the 
Transport window, tap along to the tempo with the count in and then play the line.

If the tempo is too fast, deactivate the Conductor and slow it down in the Transport window. 
After the recording, as soon as you activate the Conductor again, the 132 tempo will appear 
again.

Now play it back and listen to it. Does it sound okay? Does it need quantizing to tidy it up? 
Would you do a better job if you recorded it again?

If you answered Yes to the last question, select the Eraser in the Track window, click on the 
pattern to remove it and record it again.

If it's pretty good but you want to tighten the timing a little, Select the pattern and then 
select Quantize... from the Procedures menu.

You've recorded 1/8th notes so select 8 in the Quantize Setting box. We'd recommend a 
Percentage Change of 70 or 80 percent but we'll leave that decision up to you. If it's still not 
tight enough for you, you can increase the percentage.

Now we'll record an Orchestral Hit line. Select Track 2, click on its Rec button, open the Patch
Lists window and select Orchestra Hit.    (see page 103 of the help manual for the score 
view).

The lower notes are the same as the notes in the bass line but played two octaves higher. 
The top notes are a fifth higher. In this line the notes occur on the beat, that is on quarter 
divisions of the bar. The notes to play are as follows:

D/A      /          /            /          Bar 1
D/A      /        D/A        C/G        Bar 2
D/A      /          /            /          Bar 3
D/A      /      Eb/Bb      F/A        Bar 4

Practise the line and when you're ready, record it.

You may want to quantize this a little, too. We want the bass line and the Hits to be pretty 
tight.

Recording in step-time

We're now going to record the following string line:



If it looks complicated, don't worry - we're going to do it the easy way, in step-time.

Select Track 3, click on its Rec button and use the Patch Lists to select String Ensemble 1. In 
the Track window, select the Pencil tool and click and drag a new pattern onto Track 3 
running from bar 1 to 4.

Highlight the pattern and open the Score Editor. Make sure the Play Position is at 1:01:000. If
it isn't, click on the Return To Zero button in the Transport window.

To enter notes in step-time, click on the Step-time icon and it will turn red,

Note lengths are determined by the Note Len setting. We're going to enter 1/16th notes so 
set this to 16. You also want to be able to see the notes correctly so set the Resolution to 16,
too.

The first note doesn't occur until the second beat of the bar. You can advance the Play 
Position by the current note duration by pressing the Space Bar so press it four times to 
move on 4 x 1/16 notes. You'll see the Play Position line move and the Position indicator in 
the Transport window will advance to 1:02:000.

Now play the notes on your keyboard. The first 20 are simply a chromatic or semitone scale, 
starting on the third D above Middle C. Make sure you take your finger off each key before 
you press another one. If you don't, both notes will appear at the same position - this makes 
it easy to record chords but we don't want any in this part.

The next eight notes are:

F E F F# G A Bb C

That brings us to the end of the second bar.

Press the Space Bar eight times to move the Position to 3:02:000. The next 20 notes are the 
same as the first 20 and the final eight notes are:

Eb F F# G A Bb C D

Now play your recording and see what it sounds like. if the sounds in your module are like 
ours, you may find that the Orchestral Hit part is overpowering the others. Open the Mixer, 
flatten all the settings and adjust the volumes of the parts with the faders.

You might like to do this in Cycle mode. Click on the Cycle button and set the Left Locator 
to 1:01:000 and the Right Locator to 5:01:000.

As we've recorded it, all the patterns play at the same time. It would be more effective to 



build up to this state gradually by introducing the parts one at a time.

Hold down Control and drag Track 1 to the end of itself and then drag it again so it occurs 
three times. Move Track 2 to the start of bar 5 and then Control drag a copy to the end of 
itself. Finally, drag track 3 to the start of bar 9.

Deselect Cycle mode and click on Play. That sounds better. What it needs now is a drum 
track. This has been covered in the Drum Editor Tutorial so if you want to expand the piece, 
please carry on and do so.



The Score and Lyrics Editors Tutorial
Selecting patterns to edit
Improving the score display
Information Line
Selecting notes
Remove Overlaps
Mouse Tools
Kicking a note into pitch
Adjusting the Resolution
Score Settings
Entering Lyrics
Changing the Lyrics display
Triplets

If you read music, like working with "the dots" or want to create a score for printing, the 
Score Editor is the place to be. It shows your song in traditional music notation on the stave.

Converting a recording into notation is a tricky business because we never play music 
exactly as it is written. Even world famous concert musicians "interpret" the music by 
introducing small timing differences into their performance. It is these differences which 
make it interesting and which give it "feel".

So immediately we have a conflict between a real-time performance and printed notation. 
We don't want to lose the feel of a real-time recording but we need to remove the timing 
differences to convert it into good notation.

Fortunately, EVAP has several facilities which can help. The first thing to realise is that none 
of the Score settings and adjustments change any of the MIDI data so there is no need to 
worry about it changing your original recording. All the Score settings do is alter the way the 
score looks, not the way it sounds. However, you can also edit the notes on the stave and 
this does change the MIDI data.

Selecting patterns to edit

To see a pattern in the Score editor, you simply select it and open the Score window. 
However, there are several factors to take into consideration such as the number of patterns
selected and the MIDI channels they use.

EVAP tries to display the selected patterns in a musically sensible way. If no pattern is 
selected, the first pattern on the currently-selected track is used. If there are no patterns on 
the currently-selected track, EVAP creates one, assuming that you want one to write notes 
into.

If several patterns are selected, they are displayed in ascending order of MIDI channel. If, 
like most users, you assign MIDI channel 1 to track 1, channel 2 to track 2 and so on, then 
the stave layout will follow the order of the tracks in the Track window.

The MIDI channels are taken from the Ch column in the Track window. In other words, the 
Score editor uses the same logic as the Track window.

If Ch is set to 0, EVAP uses the MIDI channel or channels the pattern was recorded on. If a 
pattern contains notes which were recorded on more than one MIDI channel, the program 



puts each channel on a separate stave. If you don't want it to do this, simply assign the 
track a channel in the Ch column.

Improving the score display

Load the CUCKOO.SNG which is an extract from Daquin's The Cuckoo. You'll notice that the 
piece contains two tracks assigned to MIDI channels 1 and 2. Select both patterns and open 
the Score editor. Make sure the Resolution combo box is set to 16. 

If you have changed the score settings and want to get back to some default values, quit the
program, delete the DEFAULT.DEF file and restart the program.

We aren't going to pretend that this is a definitive performance but it was recorded in real-
time and created to demonstrate how the Score editor works. The timing is a little rough in 
places and you can see that the score contains lots of little inter-note rests. They were 
definitely not in the original score.

EVAP has a simple cure for these. Open the Score Settings... dialog, check the Simplify 
Display box and close it.

The lower stave is immediately brought into line, and most of the upper stave, too.

Information Line

The problem with the dotted quavers is, quite simply, that they are too long but EVAP has no
way of knowing whether it is those notes which are too long or the notes after them.

This can easily be fixed by adjusting the length, but note that you are physically about to 
change to the data and not just the score display. In some circumstances this may not be 
desirable but in many cases, including this one, the notes are clearly much longer than 
artistic interpretation calls for and a correction should even aid the performance.

Select the first problem note which is the sixth note in bar 1 by clicking on it. It will turn red 
to indicate it has been highlighted. You will see some data appear in the Information Line.

This is exactly the same as the Information Line in the Piano Roll Editor and shows the note's
Position, MIDI Channel, Pitch. Velocity and Length. Left-click on the Length parameter to take
it down to 110 or a little lower and the note will turn into a quaver!

That's one note fixed, three to go. But is there an easier way? Quantisation, perhaps?

Quantisation pushes and pulls notes onto certain divisions of the beat. It does not change 
their length. However, you may think that the recording would benefit from a little 
quantisation (yes, we agree!) so feel free to quantize it.

Note, however, that this will not change the display - try it! And remember you'll have to 
quantize to 1/16th notes so as not to disturb the two notes at the end of bar 10. 
Alternatively, you could select all the notes except those two and quantize to 1/8th.

Selecting notes

You can select notes individually by clicking on them and collectively by lassoing them as 
you have done in the other editors. You can also select and deselect notes by holding down 



Shift when you click on them.

Remove Overlaps

Open the Change Lengths... dialog in the Procedures dialog. We used this function in the 
Piano Roll Tutorial for a different purpose and although it's not a part of the Score setup, it's 
very useful for correcting scores.

Check the Remove Overlaps box, click on OK and you'll find that the score is now note 
perfect.

With the exception of an errant note which you can probably hear when you play the piece. 
It's the F natural in bar eight. It should be F sharp to let's put it right.

Mouse Tools

Like the other editors, the score editor has its own set of Mouse Tools. Activate the Mouse 
Tools selector by pressing and holding the right mouse button. Select the tool you want and 
release the button.

These are described in detail in the Reference section but most functions are self-
explanatory. The Arrow is the default tool and is used for selecting and dragging notes, and 
changing items in the Information Line.

You can click notes onto the stave with the Note cursor and remove them with the Eraser.

The Glue tool joins two notes of the same pitch together. It's a little like a tie but instead of 
drawing a tie sign between the notes it will physically turn the first one into a long note. A tie
sign will be used if the note is extended over a bar line or if the niceties of music notation 
layout demand it.

The Sharp and Flat tools raise (sharpening) and lower (flattening) notes and the Pen is 
used for entering and editing lyrics.

Kicking a note into pitch

We want to change the F natural into an F sharp. You could select it with the Arrow and then 
adjust its pitch in the Information Line. However, an easier way is simply to kick it up a 
semitone with the Sharp cursor.

Select the Sharp tool, click on the note and it will rise a semitone to F sharp.

The score is now, literally, note perfect. Let's see in what other ways we can adjust the 
format and layout.

Adjusting the Resolution

The Resolution setting is the equivalent of the Grid Resolution in the Piano Roll Editor. 
However, it has a rather different effect on the display. It determines the shortest note 
duration which will appear in the editor.



If there is a 1/16th note in the piece and you select a Resolution of 8, the 1/16th note will be 
forced onto a 1/8th beat. The Resolution is also proportional and the lower the Resolution, 
the more notes the editor will display in a given space.

Try this with the Cuckoo piece. The notes will move closer together and the score will appear
more compact although the last two 1/16th notes in bar 10 will have been squashed onto a 
1/8th note so this resolution is not suitable for this piece.

Going the other way, select a resolution of 32. This will space the notes out more - far too 
much for this piece - but you may also see that a few 1/32nd notes have appeared. This is 
because you are now allowing the program to display 1/32nd notes and if the timing is out 
by that amount these notes will show up.

Of course, if you quantized the recording - or if you want to quantize it now - using a 
quantize setting of 16, the 1/32nd notes will be moved towards 1/16th divisions of the beat 
and there will be no 1/32nd note hangers-on.

Score Settings

Put the Resolution back to 16 and open the Score Settings... window.

Most of the parameters which affect the score layout are set in this dialog. Most of the 
options are self-explanatory but they are all explained in detail anyway in the Reference 
section. Let's see what differences they make to the score.

First of all try switching off the Sloping Beams. Some people think this looks neater and in 
this piece you may agree but if you were scoring a scale of notes you'd probably find that 
sloping beams look better.

If you are printing to a dot matrix printer, sloping beams can look very stepped and you'll 
get better results switching off Sloping beams in the Printer box.

If you liked the compact display when you set the Resolution to 8, reduce the Inter-note 
value to 7 or 8. This, as you will see, determines the space between the notes. Experiment 
with the Inter-stave Spacing, too. Both these settings are extremely useful if you want to 
fit a certain number of bars onto a page.

Entering Lyrics

EVAP's Lyrics Windows displays lyrics which are present in the song. Many commercial 
"Karaoke" MIDI files contained embedded lyrics and you can easily enter your own.

Load SCARBORO.SNG which is the first part of the folk song, Scarborough Fair. It's been 
arranged using the Chords track and the Waltz accompaniment. There's more about this in 
the Chords Track Tutorial.

Open the Lyrics window which will be empty and place it at the lower right corner of the 
screen. Select the Melody track and open the Score Editor. Resize the window and put it in 
the upper left corner of the screen. Ideally, you want to see the Lyrics window, too, although 
this is not essential.

Select the Pen tool and click on the first note. A text box opens ready for you to enter in a 
word. Type "Are" followed by a space then press Tab. The word will appear under the note 



and the text box will move on to the next note. You will also see the word in the Lyrics 
window.

Now enter "you" followed by a space and press Tab again. The next word is sung across two 
notes and this is shown by splitting the word with a dash. Type "go-" (no space), press Tab 
and type "ing", press space and then Tab.

"Scarborough" is split into three. Type: "Scar-", Tab, "bor-", Tab, "ough", space, "Fair". Now we
want to start a new line so type a hash (#) which forces a new line. It appears in the Score 
window but not the Lyrics window.

Now finish off the line:

Pars-ley, Sage, Rose-mar-y and Thyme.

You don't have to worry about the rest at the start of bar 6 because you can only attach 
lyrics to notes and the editor automatically moves onto the first note in bar 6.

When you're finish, press Return which signifies the end of lyric entry.

If you make a mistake you can use Undo to remove the last entry. You can delete lyrics with 
the eraser and you can start entering lyrics again by clicking on a note with the Pen.

Now select the Lyrics window and start playback. The lyrics will highlight in turn as the Play 
Position passes the notes they are attached to.

Changing the Lyrics display

Select Lyric Font... from the Options menu

This is a standard Windows Font selector where you can choose the Font, the Font Style and 
the Font Size that you want the Lyrics window to use.

Although EVAP's Score Editor does not include music symbols, you can use the Lyric facility 
to add commands such as pp, ff and other written instructions. Set the Lyrics channel in the 
Score Settings... dialog to the part where you want to place the instructions and enter the 
instructions as Lyrics.



Thin Out Continuous Events...
Allows you to reduce the density of events such as Modulation, Pitch Bend, MIDI Volume. It 
displays a Dialog where you set the degree of thinning.

If you are thinning Controllers, there are 128 of them to choose from, including Volume, Pan, 
Data Entry etc. Set the Controller Scope to be All or Specific. If thinning a specific 
Controller, use the combo box to choose the one you want to thin out.

Special treatment is given to minimum and maximum values, and centre values for Pan and 
Pitch Bend. These are not removed, ensuring controllers can return to their default positions.



Tile Windows
Places all open windows side by side but does not disturb the Transport, Editors or Fast Menu
Windows.



Toggle Editors Caption
If the Editors Window's caption bar is visible, it is removed. When it is not visible, it is 
replaced. Turning off the caption bar frees up a little screen space.



Toggle Fast Menu Caption
If the Fast Menu Window's caption bar is visible, it is removed. When it is not visible, it is 
replaced. Turning off the caption bar frees up a little screen space.



Toggle Transport Caption
If the Transport Window's caption bar is visible, it is removed. When it is not visible, it is 
replaced. Turning off the caption bar frees up a little screen space.



Select Track Columns...
Displays a Dialog where you can choose which of the columns are displayed in the Track 
Window. For example, if you prefer to see Patch Names instead of Program numbers, turn on
the Patch switch and turn off the Program switch.



Track Window

Zoom In - display fewer bars in the same space.

Zoom Out - display more bars in the same space.

Vertical Zoom In - reduce the height of tracks.

Vertical Zoom Out - increase the height of tracks.

Add a MIDI Track - add a MIDI track if any are free.

Add a Chord Track - add a Chord Track if one does not already exist.

Add an Audio Track - add an Audio Track if one does not already exist.

To get to the furthest extent of a zoom, hold down the Control key while clicking on a zoom 
button.

Selectors

This affects how MIDI and Audio patterns line up when you move them. For example, if it is 
set to 'Bar', they will 'snap' to the nearest bar.

This affects how chord patterns line up when you move them. For example, if it is set to '4', 
they will 'snap' to the nearest quarter note.

If you drag a group of patterns which includes a mixture of pattern types, the snap setting is 
determined by which pattern in the group you click on to start dragging.

Displays

1. The Track Display shows the name of each track and various settings associated with it. 
You can choose which settings are visible by changing which Columns are visible. Click on 
any of the column headings and the Select Track Columns Dialog will be displayed. Here you 
can turn columns on and off as required.

To the right of the columns is the Divider. You can drag this left and right so that some or all
of the columns are obscured by the Pattern Display.

Track settings can be changed directly with the mouse or in the Track Settings Dialog.
If you want to give a track a different name, double click on the name and the Track Settings
Dialog is displayed. Here you can type the new name and change any of the settings which 
appear in the Track Columns.



If you click once on a track's name, you can move it up or down to a new position in the 
track list by dragging it with the mouse.

2. The Timeline shows the bars currently being displayed. The width of each bar depends 
on the Time Signature - this can change if there are Time Signature changes defined in the 
Conductor Window. If you click on the timeline with the left mouse button the left locator 
moves to the mouse position: use the right button to reposition the right locator. By clicking 
on the timeline while holding down the CONTROL key, the Play Position will jump to the 
mouse position.

3. The Pattern Display is where the patterns containing your recorded MIDI and audio data 
are displayed. They can be moved, copied, deleted or muted in order to change the 
structure of the composition. Double click on a pattern and the Pattern Settings Dialog is 
displayed. Here you can change the Pattern name and any other settings.

Chord Track Editing Controls

When the current song contains a chord track, the settings can be edited with the following 
controls:

The Style Button shows the name of the current style. Click on it to display a menu 
containing the names of all the styles.

When a Chord pattern is highlighted, the following controls are available:

Clicking on the Chord setting displays a menu of the 12 possible chord root notes.

Clicking on the Type setting displays a menu of the available chord types.

The Mute Switches control which parts of the accompaniment play in the highlighted 
chord.

Entering a Chord Sequence

To change the chord in an existing chord pattern, you first need to click on it. This highlights 
the bar and shows all settings associated with it in the Chord, Type and Mute Switch 
displays. To change the Chord (i.e. the root note), click on the Chord display and choose one 
of the 12 possible notes from the pop up menu. Similarly, the chord type can be changed by 
clicking on the Type display and choosing one of the 12 available types from the menu. If 
you double-click on a chord pattern, the Chord and Type menus are displayed automatically. 
To modify the arrangement in the pattern, use the 6 mute switches to enable playback of the
required parts of the accompaniment.

Chord patterns can be added and copied just like any other patterns.

MIDI Patterns



There are two types of MIDI pattern: Parent and Child. A parent has a solid border, a child 
has a dotted border. A child pattern has no events of its own - it plays the events of its 
parent. It also has the same name so you can see which parent it belongs to - all other 
settings can be different from the parent, however. A child pattern is created when you copy 
a parent pattern (unless the 'Copy Patterns as Parents' switch is turned on in the Preferences
Dialog). A child can be placed on the same or a different track from the parent. The 
illustration above shows a parent pattern, 'Drums1', which is followed by a child, so the 
same four bar drum pattern will play twice. If you were to change the parent in some way - 
transpose it for example - the child would be affected too as it shares the same events. If 
you were to delete the parent, the child would become a parent.

Chord Patterns

There are two types of Chord pattern: Parent and Child. A parent has a solid border, a child 
has a dotted border. A child pattern has no settings - it plays the settings of its parent. A 
child pattern is created when you copy a parent pattern (unless the 'Copy Patterns as 
Parents' switch is turned on in the Preferences Dialog).

Audio Patterns

There are two types of audio pattern: Parent and Child. A parent has a solid border, a child 
has a dotted border. A child pattern uses the same .WAV file as its parent. It also has the 
same name so you can see which parent it belongs to - all other settings can be different 
from the parent, however. A child pattern is created when you copy a parent pattern (unless 
the 'Copy Patterns as Parents' switch is turned on in the Preferences Dialog). If you delete 
the parent, the child becomes a parent. The audio pattern settings are made in the Audio 
Pattern Settings Dialog.

Audio Pattern Settings Dialog

Name The Pattern Name can contain up to 20 
characters.

Wave File This button contains the name and full path 
of the .WAV file. Pressing it calls up the file 
selector, where you can locate a wave file 
anywhere on the system.

Time A timing offset which adds the specified 
number of clock ticks to the start of the 
pattern. A negative value will make the 
pattern start early, a positive one will make it
start late.

Start and 
End

The relative positions the file starts and stops
playing (out of 1000). You can type the 
numbers or move the sliders above and 
below the Wave Display. If, for example, you 
are using a wave file which contains 4 bars of
percussion, and only want to use the second 
bar, you need to set these values to 250 and 
500.

Audition Press this button to hear the wave file and 
any effects you have assigned. You will also 
hear the MIDI tracks to help you get the 
timing right.

Stop Stops the audition playback.



Size and 
Format

Information about the wave file is displayed 
here. Use this information to set the Playback
Format in the Audio System Settings Dialog.

Volume This allows you to set a volume for the wave 
file, along with Fade In and Fade Out rates. 
The rates are tempo related.

LFO A volume effect which causes rhythmic 
beating. A value of 30 produces a 16th note 
rhythm, a value of 60 produces an 8th note 
rhythm, and so on. This is true whatever 
tempo you are using as the LFO rate is 
tempo related.

Distortion Switches on a distortion effect.
OK This button exits the Dialog and keeps the 

changes you have made.
Cancel Exits the Dialog and discards any changes 

you have made.

Track Settings

Name Can contain up to 20 characters.
Prog The MIDI Program Number.
Patch Displays the name of the Patch corresponding to the current MIDI Program 
Number.
Bank The MIDI Bank controller value, works in conjunction with the Program Number
to select variations on a sound.
Ch MIDI Channel. Values of 1 - 16 force all patterns on the track to play on the 
specified channel. A value of 0 will play the patterns on the channel(s) on which they were 
recorded.
P Port - one of the MIDI Out ports installed in the PC. If you hold down the 
Control key and click on the port setting, all tracks are assigned to the same port. A normal 
click on this setting displays a list of the open ports.
Vol MIDI Volume controller.
Pan MIDI Pan controller.
Rev MIDI Reverb Depth controller.
Chor MIDI Chorus Depth controller.
Vel Velocity modifier - added to all velocities on the track as they are played. A 
negative value reduces velocity. Does not affect the contents of the patterns.
Tran Transpose offset - added to all notes on the track as they are played. A 
negative value lowers the pitch. Does not affect the contents of the patterns.
Time A timing offset. Adds the specified number of clock ticks to the events as they 
are played back. A negative value will make the events play early, a positive one will make 
them play late.

Track Buttons

Mute Prevents any MIDI data from being sent by a track.
Solo MIDI data will be sent from the soloed track ONLY. All other tracks are muted. 
You can still click on the mute buttons to turn muting off if you want to hear other tracks as 
well as the soloed one. When you click on a solo button, the statuses of all the mute buttons 
are stored, so that when solo is turned off the mute buttons return to their previous settings.
If you then solo the SAME track the statuses of the mute buttons return to what they were 
when the track was soloed. If you solo a DIFFERENT track to last time, all mute buttons are 
turned on.
Rec Enables recording on a track. Incoming MIDI messages are rechannelized so 



they are sent from MIDI Out on the channel of the track whose Record button is turned on. If 
the channel is set to zero, the MIDI data is passed through unchanged.

Selecting Patterns

You can select patterns with either of these two methods:
1. Click on a pattern - it turns black to indicate selection. Click on another one and 

that becomes the selected pattern. If you hold SHIFT and click on a pattern you can toggle 
its status between selected and normal. By using SHIFT clicking you can select several 
patterns.

2. With the left mouse button click on a part of the Pattern Display where there isn't a
pattern. Any selected patterns become deselected. While still holding down the left mouse 
button, drag down and to the right, enclosing patterns in the dotted 'drag rectangle' as you 
go. Release the mouse button. The patterns inside the drag rectangle become selected. This 
method is called lassoing.

Using the Edit, Options & Procedures functions

When using functions from the Edit and Options menus, whether patterns are affected 
depends on their selection states. If you have selected one or more patterns, ONLY those 
patterns will be affected. If no patterns are selected, ALL patterns on the selected TRACK will
be affected.
One method of copying one or more patterns is to select them and use the Copy function 
(Edit Menu) to place a copy of them on the clipboard. You can then Paste them into the 
Pattern Display at the current Play Position.

Moving and Copying Patterns

Selected patterns can be moved and copied. Click on any one of them and drag to a new 
position then let go the mouse button. If you hold down the CONTROL key before you click, a
copy of the patterns will be made at the new position, leaving the originals intact. The newly
copied patterns then become the selected ones.

Functions Menu

Copy Track Makes a copy of the selected track including the patterns - the 
child / parent status is determined by the setting in the Preferences Dialog.
Delete Track Deletes the selected track and all the patterns on it.
Delete All Tracks Deletes all tracks and patterns.
Delete Unused Tracks Deletes all tracks which do not contain any patterns.
Pattern Dimensions... Displays a Dialog where you can type in new start and end 
positions for the selected pattern.
Insert Between Locators Inserts space between the Left and Right Locators.
Delete Between Locators Deletes everything between the Left and Right Locators.
Slice at Locators Slices all patterns at both the Left and Right Locator positions.
Chords to MIDI Track If a Chord track exists, a MIDI track is created containing all 
parts of the chord track in the current Style.
Extract Pattern If you have a pattern containing events on more than one MIDI 
channel, this function allows you to separate the events into individual patterns, each 
containing a single MIDI channel. The new patterns are allocated their own specially created 
tracks. The original pattern is not changed.
Merge Patterns This function allows you to merge a number of selected patterns
into one new pattern, which is given its own track. The original patterns are not changed.
Add MIDI Track Add a MIDI track if any are free.
Add Chord Track Add a Chord Track if one does not already exist.



Add Audio Track Add an Audio Track if one does not already exist.

Mouse Tools

To select a different mouse, hold down the right mouse button to bring up the Mouse Tool 
Selector. Move the mouse until the one you want is highlighted. Let go of the right mouse 
button - the selector disappears and the mouse cursor changes to the new shape.

1. The Arrow is at the top left so you can change back to it quickly - click the right button 
and release immediately - there's no need to drag.

2. The Pencil is used for drawing and sizing. You can draw in a new pattern or change the 
size of an existing one. To move the start position of a pattern click on the left half; to move 
the end of a pattern click on the right half. Drag the mouse to the required position and 
release the mouse button.

3. The Eraser is used to delete patterns. Click on a pattern with the eraser and it 
disappears. If you click on one of a group of selected patterns, all the selected patterns are 
deleted.

4. The Mute cursor is used to silence a pattern. Click on a pattern with the mute cursor and 
it turns grey to show it is muted. Click again and it changes back to normal.

5. The Knife is used to slice a pattern in two. The position you click on the pattern 
determines the end position of the first pattern and the start of the second one.

6. The Glue is used to join two patterns on the same track to create one new one which 
starts where the first pattern started and ends where the second one ended. Click anywhere 
on a pattern and it will be glued to the next pattern on the same track.

Multitrack Recording

When the switch is On, you can turn on as many track record (Rec) switches as you wish. 
When the switch is turned Off, the program checks to see if more than one Rec switch is on, 
and makes sure only one is left on (the top one). The Rec switches then behave as usual - 
only one can be turned on. When you turn Rec switches on and off while MIDI notes are 
passing thru, the program monitors your actions and makes sure no stuck notes occur. MIDI 
data is not rechannelized when Multitrack Recording is turned on. It is passed thru 
unchanged, to enable you to correctly hear what is being recorded. The MIDI Indicators show
the MIDI data on the track which matches the MIDI channel of the incoming data, so several 
Indicators may be flashing at the same time. This is useful to see which channels contain 
MIDI data. The Rec switches are also useful to keep out MIDI channels which you do not wish
to hear or record - only data arriving on channels enabled by a Rec switch are passed thru or
recorded.
Overdub and Replace recording modes are both supported during Multitrack Recording.
Several new patterns may be created by Multitrack Recording. All patterns which are newly 
recorded or were overdubbed into are selected to make them easy to see.



Undo & Redo

You can use the Undo function to reverse the effects of the last editing operation. You can 
then use the Redo function to reverse the effects of the Undo function.

See also:
General Window Information, Transport Window, Conductor Window, Audio System 

Settings, Preferences.



Transport Window
'Tape Recorder' Controls

Rewind is used to move the Play Position to an earlier one. If used during play, the new 
position will take effect when Rewind is released. If the right mouse button is used to press 
Rewind, the winding speed is three times as fast. If you are working in an editing window 
(e.g. Piano Roll, Event) winding speed is slower in order to give you finer control over the 
Play Position.

Similarly, Fast Forward is used to move to a later position.

Stop does just that - it stops playback or recording.

Play has two functions:
1. It starts playback when the sequencer is not running.
2. It punches out when recording is in progress - the sequencer keeps running but the

record button returns to the off position and any recorded material is displayed.

Record has two functions:
1. It starts recording when the sequencer is not running. Recording is preceded by a 

count in (unless the number of count in bars is set to zero in the Metronome Settings 
Dialog).

2. It punches in when playback is in progress - the sequencer keeps running but the 
play button returns to the off position. No count in is given in this instance - recording begins
immediately.

Auto Return

This tells the program where to send the Play Position when the sequencer stops. There are 
three possible settings:

1. Off - the Play Position stays where it is.
2. Zero - the Play Position goes to the start of the song.
3. Last Start - the Play Position goes to the position from where playback last started.

Record Mode

Click to choose either Replace or Overdub.

Toggle Switches

Metronome - turns on the metronome click, as defined in the Metronome Settings dialog.



Cycle - makes playback and recording cycle between the locators.

Follow Position - makes each window display the current song position.

Conductor - makes playback obey the contents of the Conductor Window.

Edit Solo - plays only the contents of the current edit window.

Synchronization - enables external sync, as defined in the Synchronization Settings... 
dialog.

Punch - enables automatic Punch In & Out.

Relocate Buttons

Return To Zero.

Go To End.

Display Formats

Position bars:beats:ticks.
Time hours:minutes:seconds:frames.
Left Locator bars:beats:ticks. Click on the text 'Left Locator' to jump to its position.
Right Locator bars:beats:ticks. Click on the text 'Right Locator' to jump to its 
position.
Tempo beats per minute.
Time Signature beats per bar / beat time.

Chord Detection

The Chord box works out the name of the chord currently being played on the external MIDI 
keyboard and the MIDI tracks.

Each time you press or release a new note on the external keyboard, the program 
recalculates the chord name. For example, if you hold down C, Eb and G it will show Cm. If 
you add a Bb it will change to Cm7. If you then release the Bb, the display again shows Cm.

During song playback all notes except drums are fed into the chord detector. Use the Mute 
and Solo buttons to control which notes are detected - chord detection considers only 
audible notes.

Automatic Punch In and Out



This feature is available when the Punch Switch is turned on. During playback, when the Play
Position reaches the Left Locator, the program will punch into Record - the Record button is 
'pressed' and the Play button is 'released'. When the Play Position reaches the Right Locator 
the program punches out - the Record button is 'released' and the Play button is 'pressed' 
once again.

See also:
General Window Information, Track Window, Conductor Window.



Transpose...
Allows you to change the pitch of one or more notes. It displays a Dialog where you set the 
number of Semitones, whether the notes will be transposed Up or Down, and the Scope of 
the change.



Triplets
To insert triplets - First of all, choose which editor you are going to use. Piano roll, drum 
editor or score window? Click on the corresponding icon on the editors' strip. You will be 
presented with 4 empty bars. Click on the step icon. From the Note Length box, select your 
desired triplet length. 4T would insert crotchet triplets. 8T would insert crotchet quavers 
etc...
Click on your external keyboard (or on screen keyboard) to insert your notes. The notes will 
be assigned a triplet bar as soon as three notes are detected.
If using the toolbox "note" tool to insert notes on the appropriate leger line, you can use the 
mouse position values to help with the positioning of the triplets. For example, if inserting 3 
crotchet triplets from bar 1 beat 1 , you would insert the first note on mouse position 
1:01:000    the second note would be in position 1:01:128 and the final triplet would be in 
position 1:02:064. As soon as the third triplet note was inserted, the triplet sign would be 
included.



Undo
Reverses the effect of the last editing operation. For example, if you just used the Transpose 
function (called from any window), Undo will restore the notes to their original pitches.

See also:
Redo.



View Menu
The View Menu contains the following Menu Items:

Track
Piano Roll
Event
Score
Drum
Conductor
Notepad
Mixer
Keyboard
Lyrics



Wave Files in use...
Displays a list of the .WAV files in use in the current song.



Window Menu
The Window Menu contains the following Menu Items:

Cascade Windows
Tile Windows
Arrange Icons
Close All
Configure Fast Menu...
Hide Transport...
Hide Editors...
Hide Fast Menu...
Toggle Transport Caption...
Toggle Editors...
Toggle Fast Menu...



Detailed explanation of the contents of each editing window.

Transport
Editors
Fast Menu
Keyboard
Track
Piano Roll
Event
Score
Drum
Conductor
Notepad
Mixer
Lyrics

General Window Information



XG
If you select XG mode in the Patch list dialog, a new panel appears containing 5 radio 
buttons:

XG Normal
XG User
XG SFX Voices
XG SFX Kits
XG Drum Kits

If you have a bank other than OFF, this will cause a bank message to be sent which puts that
port/channel into the XG mode you selected.

Clicking on GM or GS removes the new XG panel.

If you select XG SFX Kit or XG Drum Kit the drum flag is set, so if you go into the Routings 
dialog the drum switch for that port/channel is on, and the drum editor can be opened for 
patterns on the related track.

When you choose an XG mode, the patch list for the mode is automatically selected (if it is 
currently in memory). By default the 
program loads the 5 XG patch lists. 

Make sure your XG device is selected in the Devices dialog, and turn on XG in the Patch Lists
Dialog, then load a .MID designed for XG and the program decodes the bank messages into 
XG modes which it stores    with each track - you will see the Patch column shows XG names.
The program also recognizes the XG reset message and sends it before the set up data, 
ensuring the program changes, bank messages etc are correctly set up.
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